Project

Thermal Power
Plant

Project Description

In this project, you will create a steam driven thermal power plant. First, you will create P&ID,
plant 3D model, spec file, and pipings and fittings of the plant. Next, you will generate its
isometric and orthographic drawings. Finally, you will create and manage the reports of the
thermal power plant.
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A thermal power plant operates on the basic Rankine cycle. Heat energy obtained by burning coal
is converted into electric power with the help of a generator. Before starting with the modeling
part, it is better to have understanding of the working of an actual thermal power plant. The
stepwise working of a steam driven power plant is given below.

1.

9.

In a thermal power plant, the basic purpose is to generate electricity with the help of a
generator by running the generator shaft.

Generator shaft is run with the help of a turbine. Typically, a multistage steam turbine is
used for this purpose. A multistage steam turbine has three units: high pressure turbine,
intermediate pressure turbine, and low pressure turbine.

In order to run a turbine, you need to subject the inlet of the turbine with high pressure
and high temperature steam. This can be done with the help of a boiler. As the steam
passes through the blades of the turbine, its temperature and pressure drops towards the
outlet. Now, the steam is at low pressure and low temperature. You need to again raise the
temperature and pressure to their original state to repeat the process.

The first step is to raise the pressure. You can use a compressor for this purpose but
compressing of steam is a highly energy utilizing process which will reduce the efficiency of
the system. An easy way is to convert the steam into liquid and then boost its pressure. For
this purpose, you will introduce a condenser (heat exchanger) unit which sits beneath the
low pressure turbine.

In the condenser, a stream of cold water flows through the tubes. The steam rejects heat to
the cold water and becomes condensed. Now, you can use the pump to increase the pressure
of the water. Typically, a multistage centrifugal pump is used for this purpose.

The next task is to bring the temperature back to its original state. For this purpose, heat
is added at the exit of the pump with the help of a boiler. Thermal power plants generally
use the type of a boiler called water tube boiler. Pulverized coal is burnt inside the boiler.
The high pressure water ideally flows through an economizer.

In the economizer, the water will capture energy from the flue gas. The water flows through
a down-comer and then through the water walls where it gets converted into steam. The
pure steam is separated at a steam drum.

Now the working fluid is back to its original state (high temperature and pressure). This
steam can be fed back to the steam turbine and the cycle can be repeated continuously for

power production.

This power plant working on the basic Rankine cycle will have a very low efficiency (20-25%).

10. You can increase the performance of this system considerably with the help of few techniques.

Super heating
Reheating
Feed water heating
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11.

12.

13.

14.

15.

16.

17.

18.

19.

In case of super heating, even after converting water into steam, more heat is added to it
and with that steam becomes super heated.

The higher the temperature of the steam, the more efficient is the cycle. But the turbine
material will not withstand the temperature more than 600 degrees. So the super heating
is limited to this threshold.

The temperature of the steam decreases as it flows along the rows of the turbine blades.
Consequently, a great way to increase the efficiency of the power plant is to add more
heat after the first turbine stage. This process is known as reheating. This will increase the
temperature of the steam again leading to high power output and greater efficiency.

The low pressure sides of the turbine are prior to absorb atmospheric air even after providing
adequate sealing. The dissolved gases in the atmospheric air will spoil the boiler material
over time.

To remove these gases, an open feed water heater is introduced. Hot steam from the turbine
is mixed into the feed water. Steam bubbles so generated will absorb the dissolved gases.
The mixing also preheats the feed water which helps increase the efficiency of the power
plant to a greater extent.

All these techniques make a power plant to work under an efficiency range of 40-45%.

In an actual power plant, the heat addition and heat rejection processes are executed with
the help of a cooling tower. The cooling tower supplies the cold liquid at the condenser
inlet. The heated up water at the condenser outlet is sprayed in the cooling tower which
induces a natural air draft and the sprayed water loses heat. This is how a colder liquid is
always provided at the condenser input.

At the heat addition side, the burning coal produces many pollutants which can’t be released
directly into the atmosphere. So, before that the exhaust gases are treated in an electrostatic
precipitator.

The electrostatic precipitator uses plates with high voltage static electricity to absorb the
pollutant particles. Once the exhaust gases are treated, they are released into the atmosphere
through a chimney.

After going through the working and the concepts involved in the power plant processes, you
can start creating your project in AutoCAD Plant 3D.
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The following steps are required to complete this project:

1. Start AutoCAD Plant 3D and create a new project
Create P&ID of the plant
* Create a new P&ID drawing
e Create custom P&ID symbols
e Place equipment symbols in the drawing sheet
e Connect the equipment with lines
* Add valves to the P&ID
e Validate the drawing
* Save the drawing
3. Create plant 3D model of the plant
* Create and place equipment in the drawing
4. Create spec file for the project
* Add parts to the spec sheet
e Save the spec file
Add and modify nozzles
* Add nozzles to the turbine and generator unit
* Add nozzles to the condenser
* Add and modify nozzles of the cooling tower
*  Modify nozzles of the vertical inline pump
e Modify nozzles of the centrifugal pumpl
* Add and modify nozzles of the low pressure heater
* Add nozzles to the deaerator
e Modify nozzles of the centrifugal pump2
* Add and modify nozzles of the high pressure heater
* Add nozzles to the boiler and boiler drum
Connect the equipment
Add valves
Add structures and supports
Add ladders and railings
0. Create isometric drawings
e Create quick isometric drawing for line number 1007
e Create production isometric drawing for line number 3004
e Create production isometric drawing for line number 3006
11. Create orthographic drawings
12. Add annotations and dimensions
13. Create reports and manage data
* Filter and export the data
* Modify the data
e Import the data
e Use Autodesk AutoCAD Plant Report Creator and generate reports

(24
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Starting AutoCAD Plant 3D and Creating a New Project

1. Double-click on the AutoCAD Plant 3D 2018 - English icon from the desktop of your
computer, AutoCAD Plant 3D 2018 starts and the PROJECT MANAGER is displayed by
default on the left of the screen.
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In PROJECT MANAGER, sclect the New Project option from the drop-down list available
in the Current Project area; the Project Setup Wizard is displayed.

Enter POWER PLANT in the Enter a name for this project edit box and choose the Next
button; the Specify unit settings page is displayed.

Select the Imperial radio button if not selected by default and then choose the Next button;
the Specify P&ID settings page is displayed.

Select the PIP option from the Select the P&ID symbology standard to be used list box
if not selected by default and choose the Next button; the Specify Plant 3D directory
settings page is displayed.

Accept the default directory settings and choose the Next button; the Specify database
settings page is displayed.

Make sure the SQLite local database radio button is selected and choose the Next button;
the Finish page is displayed.

Choose the Finish button; you will notice that the POWER PLANT project is displayed
in the drop-down list available in the Current Project area of the PROJECT MANAGER.
Also, a node named POWER PLANT is created in the Project area.

Creating P&ID of the Plant

In this section, you will be working with the P&ID of the thermal power plant.

Creating a New P&ID Drawing

1.

In the PROJECT MANAGER, right-click on the P&ID Drawings node in the project tree
and then choose the New Drawing option; the New DWG dialog box is displayed.

Enter P&ID.dwg in the File name edit box and then specify the PID ANSI D -Color
Dependent Plot Styles.dwt template in the DWG template edit box.

Choose the OK button from the New DWG dialog box; the new P&ID drawing file is created
with the TOOL PALETTES displayed on the right side of the screen.

Choose the Workspace Switching button on the right of the Status Bar; a flyout is displayed.
Choose the PID PIP option from the flyout; the P&ID PIP workspace is invoked and the
TOOL PALETTES is loaded with the P&ID symbols.

To create the P&ID of the power plant, first you need to have list of equipment you are going
to use in the plant. The list of equipment is given below.

1. Turbine and Generator Unit
2. Condenser Unit

3. Centrifugal and Inline Pumps
4. LP Heater

5. HP Heater
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6. Deaerator
7. Boiler Unit
8. Cooling Tower

Creating Custom P&ID Symbols

You can create custom P&ID symbols of the equipment and add them to the TOOL PALETTES.
In this project, you need to create custom P&ID symbols for all the equipment except centrifugal
pumps. First, you will create a P&ID symbol for the Turbine and Generator unit and then add
it to the TOOL PALETTES. The stepwise procedure to do so is given next.

1.

Create a symbol of the Turbine and Generator unit, as shown in Figure P-1, using the
AutoCAD sketching tools.

High Pressure ]
Turhine Low Pressure Turbine
Insertion
Paint
Intermediate Pressure Generatar
Turbine
Figure P-1 Symbol of the Turbine and
Generator unit
Note

Assume the dimensions while creating the symbols. You can scale the symbols after inserting them
in the drawing sheet as per the requirement.

Convert the symbol created into a block named STEAM TURBINE and save the drawing.
For the insertion point of the block, refer to Figure P-1.

Click on the Equipment tab in the TOOL PALETTES - P&ID PIP. This ensures that the
custom symbol is added to the Equipment tab of the TOOL PALETTES.

Invoke the Project Setup dialog box by choosing the Project Setup tool from the Project
Manager drop-down in the Project panel of the Home tab.

In the Project Setup dialog box, expand the P&ID DWG Settings node by clicking on the
+ sign. Next, choose P&ID Class Definitions > Engineering Items > Equipment.

Click on the Mechanical Drivers sub-node; it is highlighted. Next, right-click to display a
shortcut menu and choose the New option; the Create Class dialog box is displayed, refer
to Figure P-2.
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Create Class *

Class Name:

Display Name of the Class:

| |
Carcel | [ Hep

Figure P-2 The Create Class dialog box

Enter STEAMTURBINE in the Class Name edit box; the specified name also gets displayed
as STEAMTURBINE in the Display Name of the Class edit box. Next, enter a space
after STEAM in the Display Name of the Class edit box so that the name is displayed as
STEAM TURBINE. (Note that the class name entered in the Class Name edit box should
not have any spaces in between the alphabets). Next, choose the OK button to exit the dialog
box; the specified class name gets listed and highlighted under the Mechanical Drivers
sub-node. Also, the class name (STEAM TURBINE) is displayed next to the Class settings
area.

Choose the Add Symbols button from the Symbol area; the Add Symbols - Select Symbols
dialog box is displayed, refer to Figure P-3.

A Add Symbols - Select Symbols X
Selected Drawings
Avzilable Blocks Selected Blocks:

Preview Preview

No preview available No preview available

Help

Figure P-3 The Add Symbols - Select Symbols dialog box

In this dialog box, choose the browse button next to the drop-down list in the Selected
Drawings area; the Select Block Drawing dialog box is displayed. In this dialog box, browse
to the file location and open it; the Add Symbols - Select Symbols dialog box is displayed
again with a list of blocks in the drawing file in the Available Blocks list box.
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10.

11.

12.

13.

14.

15.

Select STEAM TURBINE from the Available Blocks list box; it is highlighted. Also a preview
of the turbine block is displayed in the Preview window available below the Available Blocks
list box.

Choose the Add button; the block name is displayed in the Selected Blocks list box of the
dialog box. Choose the Next button; the Add Symbols - Edit Symbol Settings dialog box
is displayed.

Enter STEAM TURBINE in the Symbol Name edit box of the Symbol Properties area.
Choose the Yes option from the Auto Nozzle drop-down list and Flanged Nozzle Style from
the Auto Nozzle Style drop-down list of the Other Properties area. Next, choose the Finish
button to exit the Add Symbols - Edit Symbol Settings dialog box; the Project Setup dialog
box is displayed again.

Choose the Add to Tool Palette button from the Project Setup dialog box; the Create Tool
message box is displayed with a message ‘STEAM TURBINE’ tool has been added to the
current tool palette. Choose the OK button to exit the message box.

Choose the Apply and then the OK button to exit the Project Setup dialog box; the
STEAM TURBINE symbol is added to the Equipment tab.

Follow the above discussed procedure to add other equipment symbols to the
TOOL PALETTES. Refer to Figure P-4 for the shapes of the remaining equipment symbols
which are to be added to the TOOL PALETTES.



Thermal Power Plant

Insertion Paint
Type - Heat
Exchangers
— Condenser
Insertion
Paint
Type : Heat
Exchangers Low Pressure
Heater
Insertion
Paint
Type : Heat
Exchangers

High Pressure Heater

Type - Tanks

Cooling
Tower

Insertion Point

Deaerator

Type : Miscellaneous

Insertion Point Equipment

Q Boiler Drum
Insertion

Point

ol Tl
g |

Boiler

Insertion PointJ Type: Furnaces

Figure P-4 The shapes of the symbols to be added to

the TOOL PALETTES
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Placing Equipment Symbols in the Drawing Sheet

After adding all the equipment symbols to the TOOL PALETTES, now you can start inserting
them into the drawing sheet. Figure P-5 shows the final P&ID of the Power Plant (For your
reference). The stepwise procedure to add equipment symbols to the drawing sheet is given next.
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Figure P-5 P&ID of the Plant

1. Choose the Equipment tab from the TOOL PALETTES if not already chosen.

2. Choose the STEAM TURBINE tool from the Drivers and Agitator/Mixer area in the
Equipment tab of the TOOL PALETTES - P&ID PIP; you are prompted to specify an
insertion point. Next, specify (15,16) as the insertion point of the turbine and press ENTER;
the STEAM TURBINE is placed at the specified location in the drawing sheet.

Note
You can scale the equipment symbols afier inserting them into the P&ID for better visualisation.
Make sure while scaling the equipment symbols, you choose their insertion points as the base points.

3. Select the STEAM TURBINE from the drawing sheet and right-click; a shortcut menu is
displayed. Choose Annotate > Tag from the shortcut menu; the tag gets attached to the
cursor and you are prompted to specify an annotation position. Drag the cursor and place
the annotation tag below the turbine; M-? gets displayed on the screen. Next, double-click
on the annotation tag; the Edit Annotation dialog box is displayed, refer to Figure P-6.
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A Edit Annotation

Tag

Type: Mumber:

M - /D C N

Preview Cancel

Help

Figure P-6 The Edit Annotation dialog box

4. In the Edit Annotation dialog box, enter 1000 in the Number edit box and then choose
the OK button; the annotation tag M-? gets displayed as M-1000, refer to Figure P-5.

5. Choose the CONDENSER tool from the Drivers and Agitator/Mixer area of the Equipment
tab; you are prompted to specify the insertion point. Next, specify (18.5,11) as the insertion
point of the Condenser and press ENTER. The Condenser gets placed at the specified

location in the drawing sheet.

6. Follow the procedure discussed above and assign annotation tag E-100 to the Condenser.

7. Similarly, place other equipment symbols into the drawing sheet and assign annotation
tags to them. Table given below shows the equipment names, insertion coordinates, and
annotation tags to be assigned to the remaining equipment symbols which are to be added

to the drawing sheet.

EQUIPMENT INSERTION ANNOTATION TAGS
COORDINATES

Cooling Tower (24,7) TK-101
Vertical Inline Pump (Between (21,8) P-100
Line numbers 2001 and 2002)
Horizontal Centrifugal Pumpl (16,4) P-101
(Between Line numbers 1002
and 1003)
Low Pressure Heater (12,4) E-101
Deaerator (10,11) U-1000
Horizontal Centrifugal Pump2 (10,7.5) P-102
(Between Line numbers 1005
and 1006)
High Pressure Heater (6.5,4) E-102
Boiler (2.5,3) F-1000
Boiler Drum (0.9858,14.6250) F-1000A
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Note
The equipment symbols should be placed in the drawing sheet in the same sequence as given in
the table.

Connecting the Equipment with Lines

1.

Choose the Lines tab in the TOOL PALETTES - P&ID PIP, and then choose the Primary
Line Segment tool from the Pipe Lines area; you are prompted to specify the start point.
Specify the start point at the bottom of the Low Pressure Turbine and connect it to the top
of the Condenser, refer to Figure P-5. You will notice that the nozzles are added at the start
and end points of the line that lies at the bottom of the Low Pressure Turbine and top of
the Condenser.

Select the previously created line and right-click; a shortcut menu is displayed. Choose the
Assign Tag option from the shortcut menu; the Assign Tag dialog box is displayed.

In the Assign Tag dialog box, select 20” from the Size drop-down list, CS150 - 150#Carbon Steel
from the Spec drop-down list, P - GENERAL PROCESS from the Pipe Line Group Service
drop-down list, and enter 1001 in the Pipe Line Group Line Number edit box. Next, select
the Place annotation after assigning tag check box from the Existing Pipe Line Segments
area and then choose the Assign button; you are prompted to select an annotation position.
Drag the cursor and place the annotation at the suitable location, refer to Figure P-5.

Again, choose the Primary Line Segment tool from the Pipe Lines area of the Lines tab
and connect the bottom nozzle of the Condenser to the top nozzle of the Centrifugal Pump1
and assign it the tag 20”’- CGS150-P-1002, refer to Figure P-5.

Invoke the Primary Line Segment tool and connect the left nozzle of the Centrifugal
Pumpl and right nozzle of the Low Pressure Heater tagged E-101 and assign it the tag
16- CS150-P-1003, refer to Figure P-5.

Similarly, connect the other equipment using the Primary Line Segment tool, refer to
Figure P-5. Table given below shows the details of the equipment to be connected and the
tags to be assigned to the lines connecting them and Figure P-7 shows the Boiler with its
labeled components for your reference.



Thermal Power Plant

P-13

O

Super Heater
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Economiser

Figure P-7 Boiler with its labeled components

EQUIPMENT TO BE
CONNECTED

TAG

Left of LP Heater and right of Deaerator

16”-CS150-P-1004

Bottom of Deaerator and top nozzle of
Centrifugal Pump2

16”-CS150-P-1005

Left nozzle of Centrifugal Pump?2 and right
of HP Heater tagged E-102

16”’-CS150-P-1006

Left of HP Heater and bottom of Boiler
(Economiser)

20”-CS150-P-1007

Top right of Condenser and top of Cooling
Tower

12”-CS150-P-2000

Bottom of Cooling Tower and inlet nozzle of
Vertical Inline Pump

12”-CS150-P-2002

Outlet nozzle of Vertical Inline Pump
and bottom right of Condenser

12”-CS150-P-2001

Top right of Economiser and top left of
Boiler Drum

10”-CS150-P-3000

Bottom of Boiler Drum and bottom left of
Evaporator

10”-CS150-P-3001

Top of Evaporator and right of Boiler Drum

10”-CS150-P-3002

Top of Boiler Drum and left of Super Heater

10”-CS150-P-3003

Right of Super Heater and top of High
Pressure Turbine

10”-CS150-P-3004

Bottom of High Pressure Turbine and right
of Reheater

10”-CS150-P-3005

Left of Reheater and top of Intermediate
Pressure Turbine

10”-CS150-P-3006
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Choose the Primary Line Segment-Existing tool from the Pipe Lines area of the Lines tab
and connect the bottom left of the Low Pressure Turbine and the top of the Low Pressure
Heater, refer to Figure P-5.

Again, choose the Primary Line Segment-Existing tool and connect the line tagged
10”-CS150-P-3005 to the top of the High Pressure Heater, refer to Figure P-5.

Adding Valves to the P&ID

1.

Select the Valves tab in the TOOL PALETTES - P&ID PIP; the Control Valve and Valves
areas is displayed in the TOOL PALETTES.

Choose the Gate Valve tool from the Valves area; you are prompted to specify an insertion
point. Place the valve on the line tagged 20”-CS150-P-1007 at the location shown in
Figure P-5.

Similarly, place the Gate Valves on the lines tagged 10”-CS150-P-3004 and 10”-CS150-P-3006
at the locations shown in Figure P-5.

Choose the Control Valve tool from the Control Valve area; you are prompted as pick
insertion point or [Change body or actuator]. Choose the Change body or actuator option
from the command prompt; the Control Valve Browser dialog box is displayed. Select Globe
Valve from the Select Control Valve Body list box and Diaphragm Actuator from the Select
Control Valve Actuator list box and then choose the OK button. Next, place the valve on
the line tagged 10”-CS150-P-3004 at the location shown in Figure P-5; you are prompted
to select an annotation position. Drag the cursor and click on the suitable location where
you want to place the tag; the Assign Tag dialog box is displayed. Enter 3004 in the Loop
Number edit box and choose the Assign button; the tag is attached to the cursor. Place the
tag at the location, as shown in Figure P-5.

Similarly, place another Control Valve on the line tagged 10”-CS150-P-3006 and assign tag
CV-3006 to it.

After adding all the equipment, pipings, and fittings, the P&ID should look similar to the one
shown in Figure P-5.

Validating the Drawing

1.

Choose the Validate Config button from the Validate panel in the Home tab; the P&ID
Validation Settings dialog box is displayed.

In this dialog box, expand the P&ID objects node and clear the Unresolved off-page
connectors check box. Similarly, expand the 3D Model to P&ID checks node and clear all
the check boxes under it. Next, choose the OK button to close the dialog box.

Run validation process by choosing the Run Validation tool from the Validate panel; the
VALIDATION SUMMARY palette is displayed with a tree list of errors in the drawing.
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4. Right-click on any error in the VALIDATION SUMMARY palette and choose Ignore to
ignore the error. Similarly, ignore all the errors and exit the VALIDATION SUMMARY
palette.

Saving the Drawing
1. Choose the Save option from the Application Menu or choose File > Save in the menu bar
to save the drawing file.

2. Choose Close > Current Drawing from the Application Menu to close the drawing file.

Creating Plant 3D Model of the Plant

After creating the P&ID, you need to create a 3D model of the plant. To do so, you need to
create a new Plant 3D drawing. In the PROJECT MANAGER, select the Plant 3D Drawings
node and right-click; a shortcut menu is displayed. Next, choose the New Drawing option from
the shortcut menu; the New DWG dialog box gets displayed. Enter P3D in the File name edit
box and then choose the OK button; a new file P3D gets created and displayed under the Plant
3D Drawings node.

Next, click on the Workspace Switching button in the Status Bar; a flyout gets displayed. Choose
the 3D Piping option from the flyout; the 3D Piping environment gets invoked and the TOOL
PALETTES - AUTOCAD PLANT 3D - PIPING COMPONENTS gets loaded with 3D piping
components.

Creating and Placing Equipment in the Drawing

Now, you need to create and place the equipment in the drawing. After creating the P&ID of
the plant, you have a clear understanding of the equipment to be used in the plant. A list of
equipment to be used in the plant is given below for your reference.

Turbine and Generator unit
Condenser

Vertical Inline Pump
Cooling Tower
Centrifugal Pumpl
Low Pressure Heater
Deaerator
Centrifugal Pump2

9. High Pressure Heater
10. Boiler

11. Boiler Drum

S A o e

Note
While inserting the equipment in the drawing area, make sure that the Dynamic Input is turned
off and UCS 1s set to World.
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Turbine and Generator Unit

First, you will create the Turbine and Generator unit and place it in the drawing. To do so, choose
the Create Equipment tool from the Equipment panel of the Home tab; the Create Equipment
dialog box is displayed. Select the Mechanical Drivers > New Horizontal Mechanical Drivers
from the Equipment drop-down list. Next, select the Equipment tab in the dialog box if it is
not already selected.

Next, click on the Add Shape button; a flyout is displayed. Choose the Cylinder option from
the flyout; it is listed in the Shapes list box. Select the Cylinder from the Shapes list box; its
default dimensions are displayed in the Dimensions area. Next, enter 1’ and 2’ in the D and H
edit boxes, respectively. Click in the D edit box; a swatch is displayed on the right. Click on the
swatch; a flyout is displayed. Next, choose the Override mode option from the flyout.

Note

@ After entering the values in the various edit boxes in the Dimensions area of the Create Equipment
dialog box, make sure that you choose the Override mode option in all the edit boxes in which it
is available.

Again, choose the Add Shape button from the Create Equipment dialog box and choose the
Pyramid option from the flyout; it is added to the Shapes list box. Select the Pyramid from the
Shapes list box; its default dimensions are listed in the Dimensions area. Next, enter 5’, 3°, 5°,
and 6’ in the D1, D2, W, and H edit boxes, respectively. Make sure that the Downwards option
is selected from the Orientation drop-down list of the Dimensions area.

Next, follow the same procedure to add the shapes to the Shapes list box. Figure P-8 shows the
Create Equipment dialog box with list of shapes which are required to create the Turbine and
Generator unit.

A Create Equipment ®
Mechanical Drivers - Mechanical Dr| + Equipment | Properties |
S s
1 Cylinder S Long Deseription (Size)  Mecharnical Drivers
2 Pyramid Tog I
3 Cylinder 1 .
4 Pyramid
5 Pyramid
6 Cylinder
7 Pyramid Orertation Downwards v
8 Pyramid D1 %5
9 Cylinder D2 a6
10 Cylinder w 4B
11 Cylinder " e
12 Cylinder
W Add Shape
H  AddTrim
X Remove
(5] Templates Cancel Help

Figure P-8 The Create Equipment dialog box with list of Shapes
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Next, select the cylinder numbered 3 in the Shapes list box and change its dimensions to:
D=1 H=2

Similarly, for all other shapes, specify the dimension values as given below.

For Pyramid numbered 4
D1=7 D2 =3
wW=5 H=5
Orientation : Downwards

For Pyramid numbered 5
D1="7 D2 =3
w=5 H=5
Orientation : Upwards

For Cylinder numbered 6
D=1 H=2

For Pyramid numbered 7

D1 =8 D2 =3
wW=5 H=5
Orientation : Downwards

For Pyramid numbered 8

D1 =8 D2 =3
w=5 H=5
Orientation : Upwards

For Cylinder numbered 9
D=1 H=4

For Cylinder numbered 10
D=2 H = 6”

For Cylinder numbered 11
D=8 H=6

For Cylinder numbered 12
D= 29 H = 6”
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After specifying dimension values for all the shapes, click in the Tag edit box in the General
area, refer to Figure P-8; the Assign Tag dialog box is displayed. Enter 1000 in the Number
edit box and choose the Assign button to exit the Assign Tag dialog box. You can also assign
tag to the equipment using the PROPERTIES palette. Next, choose the Create button from
the Create Equipment dialog box; you are prompted to choose an insertion point. Specify the
insertion point as 54°,-134°,7°5” at the command prompt; the compass tool is displayed at the
bottom of the equipment. Set the orientation of the turbine and generator unit to 0 degrees; it
is placed at the specified point.

Condenser (Heat Exchanger unit)

Now, you need to create the Heat Exchanger unit which is a vertical Condenser in
our case. To do so, choose the Create Equipment tool from the Equipment panel
of the Home tab; the Create Equipment dialog box is displayed. Next, select the
Heat Exchanger > New Vertical Heat Exchanger from the Equipment drop-down list. Select
the Equipment tab in the dialog box if not already selected. Next, follow the same procedure
explained before to add shapes to the Shapes list box. Refer to Figure P-9 for the list of shapes
which are to be added to the Shapes list box to create the Condenser unit.

Equipment l Properties ]

Shapes:

12:1 Torispherical Head
2 Cylinder
321 Torispherical Head

Figure P-9 The list of shapes to be added to
the Shapes area

Next, select the shapes listed in the Shapes area one by one and assign dimension values to
them. The dimension values for each shape is given below.

For 2:1 Torispherical Head numbered 1
D =10’ SF = 0 T=1"

For Cylinder numbered 2
D =10 H=12

For 2:1 Torispherical Head numbered 3
D =10 SF=0 T=1"

After specifying dimension values for all the shapes, click in the Tag edit box in the General
area; the Assign Tag dialog box is displayed. Enter 100 in the Number edit box and choose
the Assign button to exit the Assign Tag dialog box. Next, choose the Create button from the
Create Equipment dialog box; you are prompted to choose an insertion point. Specify the
insertion point as 70°,-134’,-44’ at the command prompt; the compass tool is displayed at the
bottom of the equipment. Set the orientation of the Condenser unit to 90 degrees; it is placed
at the specified point.

Follow the same procedure to create and place rest of the equipment. The shapes to be added,
the dimension values and the tags to be assigned to each equipment are given next.
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Cooling Tower

Select the Tank > Vertical Tank from the Equipment drop-down list. Refer to Figure P-10 for
the shapes to be added, dimension values, and tag to be assigned.

Equipment | Properties I
Shapes

Tag TK-101

& Bevation 0
Dimensions

Upwards

D1 <& |25
D2 - |15
W - | 25"
H 40

Figure P-10 The shapes to be added, dimension values, and
lag to be assigned to the Cooling Tower

Insertion point : 5, -134°, -45’
Compass Orientation : 0 degrees

Vertical Inline Pump

Select the Pump > Vertical Inline Pump from the Equipment drop-down list. Refer to Figure P-11
for the dimension values and tag to be assigned.

Equipment | Properties I
Long Description (Size)
Tag P-100
Dimensions:

g
sSw g
SH z
DC 35
H1C 3
H2C 1-3
HM E-5'
L1MS o
D1MS 35"

Figure P-11 The dimension values and the tag to be assigned
to the Vertical Inline Pump

Insertion point : 40°, -134°, -40’
Compass Orientation : 0 degrees
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Centrifugal Pumpl
Select the Pump > Centrifugal Pump from the Equipment drop-down list. Refer to Figure P-12
for the dimension values and tag to be assigned.

Equipment | Properties I
Long Description {Size) | Centrifugal Pump
Tag P-101
Dimensions
18
SB 3
SH 6"
Sl z
S0 4
HC [
oc 4
L1BB 34
D1BB 14"
DZBB 5"
L2BB 26"
D1Ms e
L1MS 0
LMS [
D2Ms ra

Figure P-12 The dimension values and the tag to be assigned
to the Centrifugal Pumpl

Insertion point : 99°, -134’, -64’
Compass Orientation : 0 degrees

Low Pressure Heater

Select the Heater > Box Type Heater from the Equipment drop-down list. Refer to Figure P-13 for
shapes to be added and tag to be assigned.

Genesal
{F‘ Box Type Heater

Equipment | Properties |

Tag E-101
TELE Elevation 1]
4 Pyramid
5 Cube

Figure P-13 The shapes to be added and the tag to be assigned
to the Low Pressure Heater

The dimension values to be assigned to the shapes listed in the Shapes area are given next,
refer to Figure P-13.
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For Cylinder numbered 1
D = 29_6” H = 12’_11’9

For Round-to-Rectangle numbered 2

Dl = 59_5” w = 5,_5” H - 2,_11”
D2 = 2’-6” E=0” A=0
Orientation : Upwards

For Cube numbered 3
D = 59_5” W = 59_59’ H = 4,_7”

For Pyramid numbered 4

D1 =12-11” D2 = 5’-5”
W =12-11" H=2-11"
Orientation : Upwards

For Cube numbered 5

D =12-11" W =12’-11" H =16’-3"

Insertion point : 117°, -173’, -64
Compass Orientation : 180 degrees

Deaerator

Select Misc Equipment > New Vertical Misc Equipment from the Equipment drop-down list.
Refer to Figure P-14 for shapes to be added and tag to be assigned.

Equipment | Properties |
1 2:1 Torispherical Head ﬁ_\l"
2 Cylinder

Long Description (Size) | Misc Equipment
Tag 1000
Elevation 0

Figure P-14 The shapes to be added and the tag to be assigned

to the Deaerator

The dimension values to be assigned to the shapes listed in the Shapes area are given

next.

For 2:1 Torispherical Head numbered 1
D =10’ SF = 5’ T="0

For Cylinder numbered 2
D =15 H=8

Insertion point : 117°, -203’, -15’
Compass Orientation : 0 degrees
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Centrifugal Pump2
Select the Pump > Centrifugal Pump from the Equipment drop-down list. Refer to Figure P-15
for the dimension values and tag to be assigned.

Eguipment | Properties |
Long Description (Size) |Centrifugal Pump
Tag P-102
Dimensions
16
SB &
SH [
8l z
S0 &
HC &
DC &
L1BB 4
D1BB 16"
D2BE 16"
L2BB re"
D1MS r4
L1MS o
LMS &
D2MS ra

Figure P-15 The dimension values and the tag to be assigned
to the Centrifugal Pump2

Insertion point : 69’, -203’, -64’
Compass Orientation : 180 degrees

High Pressure Heater
Select the Heater > Box Type Heater from the Equipment drop-down list. Refer to Figure P-16 for
shapes to be added and tag to be assigned.

Equipment | Properties |
1 Cylinder {F‘ Long Description (Size) | Box Type Heater
2 Round-to-Rectangle Tag E102
ElEl S & Elevation 0
4 Pyramid
5 Cube

Figure P-16 The shapes to be added and the tag to be assigned
to the High Pressure Heater

The dimension values to be assigned to the shapes listed in the Shapes area are given next.

For Cylinder numbered 1
D = 2’-11” H = 13-4
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For Round-to-Rectangle numbered 2

D1 = 5-10” W = 5’-10” H = 3-4”
D2 = 2’-11” E=0” A=0
Orientation : Upwards

For Cube numbered 3
D = 5’-10” W = 5’-10” H=5

For Pyramid numbered 4
D1 =13-4” D2 = 5-10”
W=13-4" H=3-4"
Orientation : Upwards

For Cube numbered 5
D =13-4” W=13-4" H =16’-8"

Insertion point : 33’, -203’, -64°
Compass Orientation : 0 degrees

Boiler

You need a Water Tube Boiler in the plant. So you will create a custom shape for the Boiler
and then convert it into the Plant 3D component. Figure P-17 shows the dimensions which are
required to create the Boiler.

30'

12'

Figure P-17 Views and dimensions of the Boiler
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Create a 3D model of the boiler, refer to Figure P-17 for dimensions. After creating the 3D model,
you need to convert it into a Plant 3D equipment. To do so, choose the Convert Equipment
tool from the Equipment panel of the Home tab; you are prompted to select AutoCAD objects
to convert. Select the 3D model created and press ENTER; the Convert to Equipment dialog
box is displayed. Select Furnace from the Select equipment type list box and then choose the
Select button; you are prompted to specify the insertion base point. Specify the bottom left
vertex of the Boiler as the insertion point, refer to Figure P-18; the Modify Equipment dialog
box is displayed. Enter Boiler in the Long Description (Size) edit box. Next, click in the Tag
edit box; the Assign Tag dialog box is displayed. Enter 1000 in the Number edit box and then
choose the Assign button. Next, choose the Apply and then the OK button. The 3D model is
converted into Plant 3D equipment.

e+ |
Figure P-18 3D model of the Boiler
with insertion point

Next, you need to place the Boiler at the required location. Move the Boiler using the insertion
point as the base point and place it at (-46’, -196°, -64°).

Boiler Drum
Select the Furnace > New Vertical Furnace from the Equipment drop-down list. Refer to
Figure P-19 for shapes to be added, tag, and dimensions to be assigned to the Boiler Drum.

Equipment | Properties I
e
ﬁ} Long Description (Size) | Fumace
Tag F-1000A
@ Elevation 0

Figure P-19 Shapes to be added, tag, and dimension values
to be assigned to the Boiler Drum
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After assigning all the values to the Boiler Drum in the Create Equipment dialog box, choose
the Create button; you are prompted to specify the insertion point. Specify the insertion point
as (-56°, -181’, -14’) and orientation angle as 90 degrees, the Boiler Drum is placed at the
required location.

After placing all the equipment, the model should look like the one shown in Figure P-20.

Turbine and Boiler
Generator unit
High Pressure Heaterl y
|

Boiler Drum

”___ Centrifugal Cooling Tower
De aerator Pump2
Vertical Inline
Pump

Low Pressure

Heater Condenser

Centrifugal Pump1

Figure P-20 NE Isometric view of the model afier placing
all the equipments

Save the drawing by choosing the Save tool from the Quick Access Toolbar. Next, choose
Close > Current Drawing from the Application Menu.

Note
While placing the equipment into the plant model, make sure that the orientation of the equipment
is exactly similar to the one shown in Figure P-20.

Creating Spec File for the Project

After creating P&ID and placing equipment in the drawing, you need to connect the equipment.
To do so, you need to have a data file containing all pipings, fittings, valves, and other connections
required to connect the equipment to run the plant process effectively. The data file is termed
as Spec File in AutoCAD Plant 3D. To create the Spec File, double-click on the AutoCAD Plant
3D Spec Editor 2018 - English icon on the desktop of your computer; the Autodesk AutoCAD
Plant 3D Spec Editor 2018 window is displayed, as shown in Figure P-21.
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A Autodesk AutoCAD Plant 3D Spec Editor 2 - o
Fie Edit Specs Catalogs Tools Help
BESEB4sDD@ B> specedtor || B sranch Tavie avor || B Catatog Eaitor
Spec Sheet Editor Gl o
Min Size T Max Size X
AUTODESK AUTOCAD® PLANT 3D 2018 =
Spec Editor -
Spec Catalog
Create Ope:
Create from existing
reate from existing
= ecent spec files: Recent catalog files:
(J, EditParts... || [ Add Notes to Group R ASME Valves Catalog {3 Find n Catslog | | B Layout and Settings

24 POWER PLANT ASME Pipes and Fittings Catalog
CADCIM1 <05tut02 Catalog: [ Open Catalog.
CADCIM c05tut02

7}

Common filters

Resources

Help...

AutoCAD Exchange - Spec Editor
Sample files...

Part category: -

Main end conn.. Y o Schedule:

Figure P-21 The AUTODESK AutoCAD Plant 3D Spec Editor 2018 window

Choose the Create option from the Spec area of the AUTODESK AUTOCAD Plant 3D 2018
Spec Editor window; the Create Spec dialog box is displayed. Enter POWER PLANT in the
New Spec name edit box and Pipings and Fittings in the Spec description edit box. Next,
choose the ASME Pipes and Fittings Catalog option from the Load catalog drop-down list and
then choose the Create button; the Autodesk AutoCAD Plant 3D Spec Editor 2018 window is
displayed with the Spec Sheet and Catalog areas.

Adding Parts to the Spec Sheet

Now, you need to add parts to the Spec Sheet. To do so, you need to filter the parts in the
Catalog area under the Spec Editor tab by using the filter options available in it. The stepwise
procedure to add parts to the Spec Sheet are given next.

1.

Select the Pipe option from the Part category drop-down list in the Common filters area
and set the values for filters as follows:

Size range: 10 to 20
Units: in

Select the PIPE, SEAMLESS option from the Short Description drop-down list in the
Catalog Browser to show seamless pipes in it.

Select PIPE, SEAMLESS, 40, PE, ASTM A106 from the Catalog Browser and choose the
Add to Spec button from the Spec Sheet area; the part is added to the spec sheet.

Select the Apply property overrides to parts added to spec check box from the Property
overrides area in the Catalog area and enter the following values:

Material: CS
Material Code: A106
Schedule: 100
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5.

Next, select the Fittings option from the Part category drop-down list and apply the following
filters:

Size range: 10 to 20

Main end connection: FL

Short Description: REDUCER ECC
Pressure Class: 150

Select REDUCER ECC, 150LW, FF, MSS SP 51 from the Catalog Browser and choose the
Add to Spec button from the Spec Sheet area; the reducer gets added to the Spec Sheet.

Similarly, add other parts to the Spec Sheet area by filtering the Catalog Browser using the
following filter options:

Part Category: Fittings
Main end connection: FL

Size range: 10 to 20
Pressure Class: 150

Select the following parts from the Catalog Browser:

TEE, 150 LW, FF, MSS SP 51
CROSS, 150 LW, FF, MSS SP 51

Next, you need to add Flanges to the Spec Sheet.

7.

Choose the Flanges option from the Part Category drop-down list and apply the following
filters:

Main end connection: FL
Size range: 10 to 20
Short Description: FLANGE WN

Select FLANGE WN, 150 LB, RF, ASME B16.5 from the Catalog Browser and choose the
Add to Spec button; the part gets added to the Spec Sheet area.

Next, you need to add valves and actuators to the Spec Sheet.

9.

10.

Choose the Open Catalog option from the Catalog drop-down list available in the Catalog
area; the Open dialog box is displayed. In this dialog box, open the CPak ASME folder by
double-clicking on it and then open the ASME Valves Catalog.pcat file; the ASME Valves
Catalog is loaded in the Catalog area.

Select the Valves option from the Part category drop-down list and apply the following
filters:

Size range: 10 to 20
Units: in
Pressure Class 150
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11. Press and hold the CTRL key on the keyboard and select Control Valve, Ball, 150 LB, RF, ISA
75.08.02 and Gate Valve, Conduit, 150 LB, RF, ASME B16.10 from the Catalog Browser.
Next, choose the Add to Spec button; the valves are added to the Spec Sheet area.

Figure P-22 shows the Spec Sheet area after adding parts to it.

Spec: POWERPLANT

Pipings and Fittings

File Location: C:\AutoCAD Plant 3D 2018 Content\CPak Common\POWERPLANT. pspx
Last Saved: 8/18/2017 11:47:21 AM

Cross

10" to 20" CROSS, 150 LW, FF, M55 5P 51
Fange
10" to 20" FLANGE WN, 150 LB, RF, ASME B16.5
Pipe
10" to 20" PIPE, SEAMLESS, 40, PE, ASTM A106
Reducer
10" to 20" REDUCER ECC, 150 LW, FF, M35 5P 51
Tee
10" to 20" TEE, 150 LW, FF, M55 5P 51
Valve
10" to 20" Contral Valve, Ball, 150 LB, RF, ISA 75.08.02 !
10" to 20" Gate Valve, Conduit, 150 LE, RF, ASME B16.10

Figure P-22 The Spec Sheet area afier adding parts to it

In this sheet, you can notice that an error symbol is displayed next to the parts with conflicts,
refer to Figure P-22. This is because the system is not able to assign part usage priority to parts
having the same size. Click on any of the error symbols displayed in the Part Use Priority
column in the Spec Sheet; the Part Use Priority dialog box is displayed. Select 10” size from
the Size Conflicts list in the dialog box; the parts for the selected size are displayed in the Spec
Part Use Priority list. Next, move Gate Valve, Conduit, 150 LB, RF, ASME B16.10 to top in
the Spec Part Use Priority list and select the Mark as resolved check box. Similarly, move Gate
Valve, Conduit, 150 LB, RF, ASME B16.10 to the top and select the Mark as resolved check
box for all the sizes given in the Size Conflicts area. Next, choose the OK button; the dialog
box is closed and a green dot is displayed in the Part Use Priority column, indicating that the
conflict is resolved.

Saving the Spec File
1. Choose the Save As tool from the menu bar and specify the location as C:|Users\User_name)
Documents\POWER PLANT\Spec Sheets to save the file.

2. Choose File > Exit from the menu bar to close the spec file.
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Adding and Modifying Nozzles

Now, you need to modify the existing nozzles and add some new nozzles to the equipment
placed in the drawing sheet. To do so, open the P3D drawing file under Plant 3D Drawings
node in PROJECT MANAGER.

Before you start adding and modifying nozzles, you need to add the spec file, which was created
earlier, to the current project. To do so, select the Pipe Specs node from the Project area of the
PROJECT MANAGER and right-click on it; a flyout is displayed. Next, choose the Copy Specs
to Project option from the flyout; the Select Files to Copy to Project dialog box is displayed.
Next, browse to the loaction where you have saved the spec file and select it; POWER PLANT
is displayed in the File name edit box. Next, choose the Open button; the spec file is added
under the Pipe Specs node. Next, select POWER PLANT from the Spec Selector drop-down
list in the Part Insertion panel of the Home tab; the TOOL PALETTES is loaded with the parts
contained in the spec file. Now, you can start adding and modifying nozzles.

Adding Nozzles to the Turbine and Generator Unit

First, you need to add nozzles to the Turbine and Generator unit at the required locations.
To do so, select the Turbine and Generator unit from the drawing area; the Add Nozzle grip
is displayed. Click on the Add Nozzle grip; a dialog box for adding or modifying nozzles is
displayed with Change Location tab chosen. Refer to Figures P-23 and P-24 for the values and
parameters to be assigned to the nozzle. Figure P-23 shows the values to be entered in the dialog
box for adding or modifying nozzles when the Change Location tab is chosen and Figure P-24
shows the values to be entered when the Change Type tab is chosen.

Change Location |

Figure P-23 Values to be entered in the Change Location tab
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i ChangeType l#”mn glogtion )

O J a9 W
_BerrtNuzﬂeVenthzzle w

Size: 20° * | Unit: in v
End Type: FL * | Pressure Class: | 150 v
| Select Nozzle

Maozzle, flanged, 207 ND, FF, 150, ASME B16.5
Naozzle, flanged, 20° ND, RF, 150, ASME B16.5

MNaozzle, flanged, 207 ND, RT), 150, ASME B16.5

Figure P-24 Values to be entered in the Change Type
tab

Next, select Nozzle, flanged, 20 ND, RF, 150, ASME B16.5 from the Select Nozzle area by
double-clicking on it and then choose the Close button; the nozzle is placed at the bottom center
of the Low Pressure Turbine.

Next, you need to place a nozzle at the top center of Intermediate Pressure Turbine. Figure P-25
shows the values to be entered in the dialog box for adding or modifying nozzles when the
Change Location tab is chosen and Figure P-26 shows the values to be entered when the Change
Type tab is chosen.

Mozzle Location: | Radial v
H
: e T —— . .
A End Type: FL * | Pressure Class: | 150 v

Figure P-25 Values to be entered in the Figure P-26 Values to be entered in the Change Type
Change Location tab tab

Next, select Nozzle, flanged, 10 ND, RF, 150, ASME B16.5 from the Select Nozzle area by
double-clicking on it and then choose the Close button; the nozzle is placed at the top center
of the Intermediate Pressure Turbine.

Similarly, you can place two more nozzles on the High Pressure Turbine. Figures P-27 and P-28
show the values to be entered in the dialog box for adding or modifying nozzles when the Change
Location and Change Type tabs are chosen, respectively. Using these values, you can place the
nozzle at the top of High Pressure Turbine.
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Mozzle Location: | Radial

:
I B 0w i :
A ag End Type: FL “ | Pressure Class: | 130 M

*,

Figure P-27 Values to be entered in the — Figure P-28 Values to be entered in the Change Type
Change Location tab lab

After entering all values in the dialog box, select Nozzle, flanged, 10” ND, RF, 150, ASME
B16.5 from the Select Nozzle area by double-clicking on it and then choose the Close button;
the nozzle is placed at the top of the High Pressure Turbine.

Figures P-29 and P-30 show the values to be entered in the dialog box for adding or modifying
nozzles when the Change Location and Change Type tabs are chosen, respectively. Using these
values, you can place the nozzle at the bottom of the High Pressure Turbine.

Nozzle Location: | Radial

H

-~ &)

Size: 10" * | Unit: in v

L

€

A 570 End Type: FL ¥ | Pressure Class: | 150 i

.,

Figure P-29 Values to be entered in the  Figure P-30 Values to be entered in the Change Type
Change Location tab tab
Next, choose Nozzle, flanged, 10” ND, RF, 150, ASME B16.5 from the Select Nozzle area by
double-clicking on it and then choose the Close button; the nozzle is placed at the bottom of
the High Pressure Turbine.

Adding Nozzles to the Condenser

Next, you need to add four nozzles to the Condenser (one at the top and three radial nozzles).
Figure P-31 shows the Condenser in Back view labeled with nozzle numbers. Note that the
nozzles are labeled only for your reference.

’— Nozzle 1

MNozzle 4

Nozzle 2

Nozzle 3

Figure P-31 Condenser labeled with nozzle numbers
(in Back view)
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Figures P-32 through P-35 show the values to be entered for nozzles labeled 1 to 4 in the
Change Location and the Change Type tabs, respectively.

For Nozzle 1

Size: 20" “ | Unit: in “

A |i| End Type: FL ¥ | Pressure Class: | 150 =

Figure P-32 lalues to be entered in the Change Location and Change Type tabs
for Nozzle 1

After entering all the values under both the tabs, select Nozzle, flanged, 20 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

For Nozzle 2

Nozzle Location: | Radial v
:
S 7 um - .
A End Type: FL * | Pressure Class: | 150 v

Figure P-33 lalues to be entered in the Change Location and Change Type tabs
for Nozzle 2

Next, select Nozzle, flanged, 12 ND, RF, 150, ASME B16.5 from the Select Nozzle area of the
Change Type tab by double-clicking on it and then choose the Close button.

For Nozzle 3

Mozzle Location: | Radial v
:
L Size: 12 “ | Unit: in v
A End Type: FL “ | Pressure Class: | 150 v

Figure P-34 Values to be entered in the Change Location and Change Type tabs
for Nozzle 3
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Next, select Nozzle, flanged, 12 ND, RF, 150, ASME B16.5 from the Select Nozzle area of the
Change Type tab by double-clicking on it and then choose the Close button.

For Nozzle 4

Nozzle Location: | Radial

H

#~ -

Size: 207 * | Unit: in v

L

-y
<

A 270 End Type: FL * | Pressure Class: | 150 v

. s

Figure P-35 Values to be entered in the Change Location and Change Type tabs
for Nozzle 4

Next, select Nozzle, flanged, 20 ND, RF, 150, ASME B16.5 from the Select Nozzle area of the
Change Type tab by double-clicking on it and then choose the Close button.

Adding and Modifying Nozzles of the Cooling Tower

Next, you need to add two nozzles to the Cooling Tower at the required locations and remove
the existing ones. First, you will delete the existing nozzles of the Cooling Tower. To do so, press
the CTRL key and select all the existing nozzles. Next, press the DELETE key. All the existing
nozzles is deleted. Now, you will add nozzles at the required locations. Figure P-36 shows the
Cooling Tower labeled with nozzle numbers.

Nozzle 2

MNozzle 1

Figure P-36 Cooling Tower labeled with nozzle numbers

7 Y Tip
\@f You can also modify the existing nozzles of the Cooling Tower instead of deleting them.

N

Figures P-37 and P-38 show the values to be entered (for nozzles labeled 1 and 2) in the
Change Location and Change Type tabs, respectively.
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For Nozzle 1

Mozzle Location: | Radial v

:
L Size: 127 * | Unit: in v

—

A End Type: FL “ | Pressure Class: | 150 i

Figure P-37 Values to be entered in the Change Location and Change Type tabs
for Nozzle 1

After entering all the values under both the tabs, choose Nozzle, flanged, 12 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

For Nozzle 2

Nozzle Location: | Radial v
:
L Size: 127 * | Unit: in v
A 0 End Type: FL “ | Pressure Class: | 130 v

Figure P-38 Values to be entered in the Change Location and Change Type tabs
for Nozzle 2

Next, select Nozzle, flanged, 12 ND, RF, 150, ASME B16.5 from the Select Nozzle area of the
Change Type tab by double-clicking on it and then choose the Close button.

Modifying Nozzles of the Vertical Inline Pump

Now, you need to modify the existing nozzles of the Vertical Inline Pump. To do so, select the
Vertical Inline Pump from the drawing area; two pencil grips is displayed on it. Next, click on the
pencil grip which is closer to the Cooling Tower; a dialog box for adding or modifying nozzles
is displayed. Choose the Change Location tab and enter the values shown in Figure P-39. Next,
choose the Change Type tab and enter the values shown in Figure P-40.

Change Location | . ;
/ Size: 12 * | Unit: in v

cc End Type: FL | Pressure Class: | 130 ¥

Figure P-39 Values to be entered in the Figure P-40 Values to be entered in the Change Type
Change Location tab tab

After entering all the values under both the tabs, select Nozzle, flanged, 12 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.
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Again, select the Vertical Inline Pump and click on the other pencil grip; a dialog box for adding
or modifying nozzles is displayed. Choose the Change Location tab and enter the values shown
in Figure P-41. Next, choose the Change Type tab and enter the values shown in Figure P-41.

Change Location

Size: 12* * | Unit: in v

LC &' End Type: FL * | Pressure Class: | 130 ¥

Figure P-41 Values to be entered in the Change Location and Change Type tabs

After entering all the values under both the tabs, choose Nozzle, flanged, 12”” ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button. Figure P-42 shows the Vertical Inline Pump after modifying the
nozzles.

Figure P-42 Vertical inline pump afier modifying nozzles

Modifying Nozzles of the Centrifugal Pumpl

Now, you need to modify the existing nozzles of the Centrifugal Pumpl. To do so, select the
Centrifugal Pump1 from the drawing area; two pencil grips are displayed on it. Click on the grip
which is displayed on the inlet side of the pump; a dialog box for adding or modifying nozzles
is displayed. Choose the Change Location tab and enter the values shown in Figure P-43. Next,
choose the Change Type tab and enter the values shown in Figure P-44.

Change Location Size: 20" “ | Unit: in Y

LF2C & End Type: FL “ | Pressure Class: | 130 M

Figure P-43 Values to be entered in the  Figure P-44 Values to be entered in the Change Type
Change Location tab tab



P-36 AutoCAD Plant 3D 2018 for Designers

After entering all the values under both the tabs, choose Nozzle, flanged, 20 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

Similarly, to modify the outlet nozzle of the pump, enter the values shown in Figures P-45 and
P-46 under the Change Location and Change Type tabs, respectively.

Ch.anﬁe Location |

il Size: 16 ¥ | Unit: in i

PF1C End Type: FL * | Pressure Class: | 150 v

Figure P-45 Values to be entered in the Figure P-46 lalues to be entered in the Change Type
Change Location tab lab

After entering all the values under both the tabs, choose Nozzle, flanged, 16 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

Adding and Modifying Nozzles of the Low Pressure Heater
Now, you need to delete the existing nozzles of the Low Pressure Heater and add new nozzles
to it at the required locations. So, you will first remove the existing nozzles of the Low Pressure

Heater. To do so, press the CTRL key and select all the existing nozzles at once and then press
the DELETE key.

Next, follow the same procedure to add two nozzles to the Low Pressure Heater. Figures P-47
and P-48 show the values to be entered under the Change Location and Change Type tabs for
the first nozzle (the one facing Centrifugal Pumpl).

Nozzle Location: | Radial v
;
v ] size | - “
A 570 End Type: FL ¥ | Pressure Class: | 150 =

Figure P-47 Values to be entered in the Figure P-48 Values to be entered in the Change Type
Change Location tab lab

After entering all the values under both the tabs, choose Nozzle, flanged, 16 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

Figures P-49 and P-50 show the values to be entered under the Change Location and Change
Type tabs for the second nozzle (the one facing Deaerator).
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Mozzle Location: | Radial v
H
: iz T um > .
A End Type: FL * | Pressure Class: | 150 v

Figure P-49 Values to be entered in the Figure P-50 Values to be entered in the Change Type
Change Location tab tab

After entering all the values under both the tabs, choose Nozzle, flanged, 16 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

Adding Nozzles to the Deaerator
Now, you need to add two nozzles to the Deaerator. Figures P-51 and P-52 show the values to be

entered under the Change Location and Change Type tabs for the first nozzle (the one facing
Low Pressure Heater).

Nozzle Location: | Radial v
-
A End Type: FL “ | Pressure Class: | 150 v

Figure P-51 lalues to be entered in the Figure P-52 Values to be entered in the Change Type
Change Location tab is chosen tab

After entering all the values under both the tabs, choose Nozzle, flanged, 16 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

Figures P-53 and P-54 show the values to be entered under the Change Location and Change
Type tabs for the second nozzle (the one at the bottom center of Deaerator).

MNozzle Location: | Bottom v
R
L Sze & <|um = ,
A II' End Type: FL * | Pressure Class: | 130 v

Figure P-53 Values to be entered in the Figure P-54 Values to be entered in the Change Type
Change Location tab tab



P-38 AutoCAD Plant 3D 2018 for Designers

After entering all the values under both the tabs, choose Nozzle, flanged, 16 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

Modifying Nozzles of the Centrifugal Pump2

Now, you need to modify the existing nozzles of the Centrifugal Pump2. To do so, select the
Centrifugal Pump2 from the drawing area; two pencil grips are displayed on it. Next, click on
the grip displayed on the inlet side of the pump; a dialog box for adding or modifying nozzles
is displayed. Choose the Change Location tab and enter the values shown in Figure P-55. Next,
choose the Change Type tab and enter the values shown in Figure P-56.

Ch.a.nﬁe Location |
16"

Size: ¥ | Unit: in M
LF2C End Type: FL “ | Pressure Class: | 130 M

Figure P-55 Values to be entered in the Figure P-56 Values to be entered in the Change Type
Change Location tab tab

After entering all the values under both the tabs, choose Nozzle, flanged, 16 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

Similarly, to modify the outlet nozzle of the pump, enter the values shown in Figures P-57 and
P-58 under the Change Location and Change Type tabs, respectively.

Ch.a.nﬁe Location |

LFIC 31 Size: 16* ¥ | Unit: in M
PF1C End Type: FL “ | Pressure Class: | 130 M

Figure P-57 Values to be entered in the Figure P-58 lalues to be entered in the Change Type
Change Location tab tab

After entering all the values under both the tabs, choose Nozzle, flanged, 16 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

Adding and Modifying Nozzles of the High Pressure Heater

Now, you need to delete the existing nozzles of the High Pressure Heater and add new nozzles
to it at the required locations. First, you will delete the existing nozzles of the High Pressure
Heater. To do so, press the CTRL key and select all the existing nozzles at once and then press
the DELETE key.
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Next, follow the same procedure as explained before to add two nozzles to the High Pressure
Heater. Figures P-59 and P-60 show the values to be entered under the Change Location and
Change Type tabs for the first nozzle (the one facing Centrifugal Pump?2).

Mozzle Location: | Radial v
H
: Size Ta— = v
A |I| End Type: FL “ | Pressure Class: | 150 v

Figure P-59 Values to be entered in the  Figure P-60 Values to be entered in the Change Type
Change Location tab lab

After entering all the values under both the tabs, choose Nozzle, flanged, 16> ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

Figures P-61 and P-62 show the values to be entered under the Change Location and Change
Type tabs for the second nozzle (the one facing Boiler).

Nozzle Location: | Radial v

H

L

II

Size: 207 * | Unit: in v

: FL ~ . | 150 v
A 180 End Type: Pressure Class:

Figure P-61 Values to be entered in the  Figure P-62 Values to be entered in the Change Type
Change Location tab tab

After entering all the values under both the tabs, choose Nozzle, flanged, 20 ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and
then choose the Close button.

Adding Nozzles to the Boiler and Boiler Drum

Now, you will place nozzles on the Boiler which is a custom equipment you created earlier. To
do so, select the Boiler from the drawing area; the Add Nozzle grip is displayed on it. Click on
the Add Nozzle grip, you are prompted to specify the nozzle center. Press and hold the SHIFT
key and then right-click; a flyout is displayed. Next, choose the From option from the flyout;
you are prompted to specify the base point. Specify the base point at the bottom left vertex of
the Boiler, refer to Figure P-63. After specifying the base point, you are prompted to specify the
offset value. Enter @-6°,12,0’ at the command prompt; you are prompted to specify the nozzle
direction. Move the cursor vertically down and click to specify the nozzle direction; a dialog box
for adding or modifying nozzles is displayed. Next, choose the Change Type tab and enter the
values shown in Figure P-64.
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Base Point

Figure P-63 Base point to be selected while using

From snap
Size: 20" ~ | Unit: in v
End Type: FL ¥ | Pressure Class: | 150 i

., o

Figure P-64 Values to be entered in the Change Type
lab

After entering all the values under the Change Type tab, choose Nozzle, flanged, 20”” ND, RF,
150, ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on
it and then choose the Close button.

Now, you have specified the nozzle location. Next, you need to place a flange at the nozzle
point. To do so, choose FLANGE WN, FL, RF, 150, (POWER PLANT) from the Flange area
in the Dynamic Pipe Spec tab of the TOOL PALETTES - AUTOCAD PLANT 3D - PIPING
COMPONENTS; you are prompted to specify the insertion point. Press and hold the SHIFT
key and right-click, a flyout is displayed. Next, choose the Node option from the flyout and
place the flange at the node of the nozzle point located earlier; you are prompted to specify the
rotation angle. Specify the rotation angle as 0 degrees using the cursor and then press the ESC
key; the flange is placed at the specified location, as shown in Figure P-65.

Figure P-65 Flange placed at the specified location
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Note
@ While specifying coordinates for the placement of nozzles on the Boiler unit, make sure that the
' UCS is set to World.

Now, you need to add nozzles at the top face of the Boiler. Figure P-66 shows the Boiler labeled
with nozzle numbers which are required to be placed at its top face.

Base Point for

all nozzles
Nozzle 1

Nozzle 2

Nozzle 4

Nozzle &

Figure P-66 10p face of the Boiler with labeled nozzles

Nozzle 1

To place nozzle 1, select the Boiler from the drawing area; the Add Nozzle grip is displayed.
Click on the Add Nozzle grip; you are prompted to specity the nozzle center. Press and hold the
SHIFT key and then right-click; a flyout is displayed. Next, choose the From option from the
flyout, you are prompted to specify the base point. Specify the base point, refer to Figure P-66;
you are prompted to specify the offset value. Enter @6’,-6’,0” at the command prompt, you are
prompted to specify the nozzle direction. Move the cursor vertically up and click to specify the
nozzle direction; a dialog box for adding or modifying nozzles is displayed. Next, choose the
Change Type tab and enter the values shown in Figure P-67.

- -

Size: 1o ¥ | Unit: in i

End Type: FL * | Pressure Class: | 150 v

*, s

Figure P-67 Values to be entered in the Change Type
tab

After entering all the values under the Change Type tab, choose Nozzle, flanged, 10 ND, RF,
150, ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on
it and then choose the Close button. This step will remain same for rest of the nozzles to be
placed on the boiler.
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Now, you have specified the nozzle location. Next, you need to place a flange at the nozzle point.
To do so, choose the FLANGE WN, FL, RF, 150, (POWER PLANT) from the Flange area in
the Dynamic Pipe Spec tab of the TOOL PALETTES - AUTOCAD PLANT 3D - PIPING
COMPONENTS; you are prompted to specify the insertion point. Press and hold the SHIFT
key and right-click, a flyout is displayed. Next, choose the Node option from the flyout and
place the flange at the node of the nozzle point located earlier; you are prompted to specify the
rotation angle. Specify the rotation angle as 0 degree using the cursor and then press the ESC
key; the flange is placed at the required location, refer to Figure P-66.

Similarly, place the other nozzles at the required locations, refer to Figure P-66. Note that
the base point will remain same for all the nozzles while using the From snap and the nozzle
direction is vertically upwards for all the nozzles. The offset values for nozzles numbered 2 to
5 are given next.

Nozzle 2 : @12°,-6°,0°
Nozzle 3 : @16°,-12°,0°
Nozzle 4 : @20°,-12°,0’
Nozzle 5 : @6°,-20°,0’

After specifying the nozzle points, place FLANGE WN, FL, RF, 150, POWER PLANT) at all
the nozzle points. After placing the flanges, the top face of Boiler should look similar to the
one shown in Figure P-66.

Next, you need to place two nozzles, one at the front and other at the back face of the Boiler.
First, you will place the nozzle on the front face. To do so, follow the same procedure as explained
before. Refer to Figure P-68 for the base point to be selected while using the From snap.

Base point

Figure P-68 Base point to be selected while using the
From snap

Offset value for nozzle on front face : @0°,12°,8’
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Similarly, place the nozzle on back face of the Boiler. Refer to Figure P-69 for the base point to
be selected while using the From snap.

Base Point

Figure P-69 Base point to be selected while using the
From snap

Offset value for nozzle on back face : @0,0,12°

After specifying the nozzle points on the front and back faces, place FLANGE WN, FL, RF,
150, (POWER PLANT) at both the nozzle points.

Next, you need to place nozzles on the Boiler Drum. Figure P-70 shows the Boiler Drum labeled
with nozzle numbers.

l— Mozzle 3

MNozzle 2 Nozzle 1

Nozzle 4

Figure P-70 Boiler Drum labeled with nozzle numbers

Figures P-71 through P-74 show the values to be entered (for nozzles labeled 1 to 4) in the
Change Location and the Change Type tabs, respectively.
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For Nozzle 1

Nozzle Location: | Radial

<

;
S o e " :
A 270 End Type: FL * | Pressure Class: | 150 v

Figure P-71 Values to be entered in the Change Location and Change Type labs
for Nozzle 1

After entering all the values under both the tabs, choose Nozzle, flanged, 10” ND, RF, 150,
ASME B16.5 from the Select Nozzle area of the Change Type tab by double-clicking on it and

then choose the Close button. This step will remain same for all the nozzles to be placed on
the Boiler Drum.

For Nozzle 2

Mozzle Location: | Radial v
H
: Size T = v
A End Type: FL “ | Pressure Class: | 150 v

Figure P-72 Values to be entered in the Change Location and Change Type tabs
for Nozzle 2

For Nozzle 3

Mozzle Location: | Top

<

R

Size: 1o ¥ | Unit: in
A

1

End Type: FL * | Pressure Class: | 150 v

Figure P-73 TValues to be entered in the Change Location and Change Type tabs
for Nozzle 3
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For Nozzle 4

MNozzle Location: | Bottom v
R
L Size: 107 * | Unit: in w
A Iil End Type: FL * | Pressure Class: | 130 v

Figure P-74 Values to be entered in the Change Location and Change Type labs
for Nozzle 4

Connecting the Equipment
After placing the nozzles at the required locations, you need to connect the equipment. This
can be done by making piping connections between the equipment.

First, you will connect the Low Pressure Turbine with the Condenser. To do so, choose the
Route New Line option from the Line Number Selector drop-down of the Part Insertion panel;
the Assign Tag dialog box is displayed. Enter 1001 in the Number edit box in this dialog box.
Next, select the line size as 20” from the Size drop-down list. Next, choose the Assign button;
the Assign Tag dialog box is closed and you are prompted to specify the start point of the pipe.
Press and hold the SHIFT key and right-click to display a shortcut menu. Choose the Node
option from the shortcut menu displayed and then select the node of the nozzle located at the
bottom of the Low Pressure Turbine; you are prompted to specify the next point. Move the cursor
vertically down and select the node of the nozzle located at the top of the Condenser, the pipe
is added between the two nozzles, as shown in Figure P-75.

Figure P-75 Pipe added between bottom nozzle of the
Low Pressure Turbine and top nozzle of the Condenser
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Next, you will connect the lower nozzle of the Cooling Tower with the inlet nozzle of the Vertical
Inline Pump. To do so, choose the Route New Line tool from the Line Number Selector
drop-down of the Part Insertion panel; the Assign Tag dialog box is displayed. Enter 2002 in
the Number edit box in this dialog box. Select the line size as 12 from the Size drop-down
list. Next, choose the Assign button; the Assign Tag dialog box is closed and you are prompted
to specify the start point of the pipe. Press and hold the SHIFT key and right-click to display a
shortcut menu. Choose the Node option from the shortcut menu displayed and then select the
node of the lower nozzle of the Cooling Tower; you are prompted to specify the next point. Move
the cursor horizontally towards the Vertical Inline Pump and select the node of the inlet nozzle
of the Vertical Inline Pump, the pipe is added between the two nozzles as shown in Figure P-76.

Figure P-76 Pipe added between lower nozzle of the Cooling Tower and
inlet nozzle of the Vertical Inline Pump

Next, you need to connect the outlet nozzle of the Vertical Inline Pump with the lower radial
nozzle of the Condenser. Follow the same procedure explained before to connect the equipment
and refer to Figure P-77 for the values to be assigned in the Assign Tag dialog box.

Tag: |2CI]'I
Number: |2001

Size: |12"
Spec: |POWER PLANT

Figure P-77 Values to be assigned in the
Assign Tag dialog box

Figure P-78 shows the pipe connected between the Vertical Inline Pump and the Condenser.
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Figure P-78 Pipe added between outlet nozzle of
the Vertical Inline Pump and lower radial nozzle of
the Condenser

Next, you need to add a pipe between the upper radial nozzle of the Condenser with the upper
nozzle of the Cooling Tower. To do so, choose the Route New Line tool from the Line Number
Selector drop-down of the Part Insertion panel; the Assign Tag dialog box is displayed. Enter
2000 in the Number edit box in this dialog box. Select the line size as 12” from the Size
drop-down list. Next, choose the Assign button; the Assign Tag dialog box is closed and you are
prompted to specify the start point of the pipe. Press and hold the SHIFT key and right-click
to display a shortcut menu. Choose the Node option from the shortcut menu displayed and
then select the node of the upper nozzle of the Condenser; you are prompted to specify the
next point. Move the cursor horizontally towards the Cooling Tower and select the node of the
upper nozzle of the Cooling Tower. Next, press ENTER to accept the suggested piping solution.
Figure P-79 shows the pipe connected between the upper radial nozzle of the Condenser and
the upper nozzle of the Cooling Tower.

Figure P-79 Pipe added between upper radial nozzle of the
Condenser and upper nozzle of the Cooling Tower

Now, you need to connect the radial nozzle of the Condenser facing the Centrifugal Pumpl
with the inlet nozzle of the Centrifugal Pump1. To do so, choose the Route New Line tool from
the Line Number Selector drop-down of the Part Insertion panel; the Assign Tag dialog box
is displayed. Enter 1002 in the Number edit box in this dialog box. Select the line size as 20”
from the Size drop-down list. Next, choose the Assign button; the Assign Tag dialog box is
closed and you are prompted to specify the start point of the pipe. Press and hold the SHIFT
key and right-click to display a shortcut menu. Choose the Node option from the shortcut menu
displayed and then select the node of the radial nozzle of the Condenser; you are prompted to
specify the next point. Move the cursor towards the Centrifugal Pump1 and select the node of
the inlet nozzle of the Centrifugal Pumpl. Next, press ENTER to accept the suggested piping
solution. Figure P-80 shows the pipe connected between the radial nozzle of the Condenser and
the inlet nozzle of the Centrifugal Pumpl.
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Figure P-80 Pipe added between upper radial nozzle
of the Condenser and inlet nozzle of the Centrifugal
Pumpl

Similarly, connect the outlet nozzle of the Centrifugal Pumpl with the inlet nozzle of Low
Pressure Heater. Refer to Figure P-81 for the values to be assigned in the Assign Tag dialog box.

Tag: |'IDD3 |
MNumber: |'IDD3 |
Size: |1G" |

|

Spec: |POWER PLANT

Figure P-81 Values to be assigned in the
Assign Tag dialog box

Note that you have to click on Next option and then choose the Accept option in the command
prompt when you are prompted to specify the piping solution. Figure P-82 shows the pipe
connected between the outlet nozzle of the Centrifugal Pump1 and the inlet nozzle of the Low
Pressure Heater.

Figure P-82 Pipe added between outlet nozzle of the Centrifugal
Pumpl and inlet nozzle of the Low Pressure Heater
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Similarly, connect the outlet nozzle of the Low Pressure Heater with the inlet nozzle of the
Deaerator. Refer to Figure P-83 for the values to be assigned in the Assign Tag dialog box. The
pipe connected should look like the one shown in Figure P-84.

Tag: |1DD-1
MNumber: |1DD-1|
Size: |1G"
Spec: [POWER PLANT

Figure P-83 Values to be assigned in the
Assign Tag dialog box

Figure P-84 Pipe added between the outlet nozzle
of the Low Pressure Heater and inlet radial nozzle
of the Deaerator

Next, connect the outlet nozzle of the Deaerator with the inlet nozzle of the Centrifugal Pump?2.
Refer to Figure P-85 for the values to be assigned in the Assign Tag dialog box. The pipe
connected should look like the one shown in Figure P-86.

Tag: |1D|15 |
Mumber: |1DDE4 |
Size: |'|'5" |
Spec: |POWER PLANT |

Figure P-85 Values to be assigned in the
Assign Tag dialog box
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Figure P-86 Pipe added between the outlet nozzle of the
Deaerator and inlet nozzle of the Centrifugal Pump2

Next, connect the outlet nozzle of the Centrifugal Pump2 with the inlet nozzle of the High
Pressure Heater. Refer to Figure P-87 for the values to be assigned in the Assign Tag dialog box.
The pipe connected should look like the one shown in Figure P-88.

Tag: |11II':‘
Number: |'I{H}G|
Size: |1G"
Spec: |POWER PLANT

Figure P-87 Values to be assigned in the
Assign Tag dialog box

Figure P-88 Pipe added between the outlet nozzle of Centrifugal Pump2
and the inlet nozzle of High Pressure Heater
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Next, connect the outlet nozzle of the High Pressure Heater with the inlet nozzle of the
Economiser unit on the Boiler. Refer to Figure P-89 for the values to be assigned in the Assign Tag
dialog box. The pipe connected should look like the one shown in Figure P-90.

Tag: 1007 |
Number: | 1007 |
Size: | 20" ~

Spsc: |POWER PLANT |

Figure P-89 Values to be assigned in the
Assign Tag dialog box

Figure P-90 Pipe added between outlet nozzle of the High Pressure
Heater and inlet nozzle of the Economiser unit on the Boiler

Now, connect the outlet nozzle of the Economiser unit with the left radial nozzle on the Boiler
Drum. To do so, choose the Route New Line tool from the Line Number Selector drop-down
of the Part Insertion panel; the Assign Tag dialog box is displayed. Enter 3000 in the Number
edit box in this dialog box. Select the line size as 10” from the Size drop-down list. Next, choose
the Assign button; the Assign Tag dialog box is closed and you are prompted to specify the
start point of the pipe. Press and hold the SHIFT key and right-click to display a shortcut menu.
Choose the Node option from the shortcut menu displayed and then select the node of the outlet
nozzle of the Economiser unit; you are prompted to specify the next point. Move the cursor
horizontally towards right and enter 4’ at the command prompt; you are prompted to specify
the next point. Next, choose the Plane option from the command prompt. Move the cursor
vertically upwards and enter 25’ at the command prompt. Next, press and hold the SHIFT key
and right-click; a shortcut menu is displayed. Choose the Node option from the shortcut menu
and select the node of the left radial nozzle on the Boiler Drum.

Next, press ENTER to accept the suggested piping solution. The pipe connected should look
like the one shown in Figure P-91.
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Figure P-91 Pipe added between the outlet nozzle of
Economiser unit and left radial nozzle of the Boiler Drum

Next, connect the bottom nozzle of the Boiler Drum to the inlet nozzle of the Evaporator
unit. Refer to Figure P-92 for the values to be assigned in the Assign Tag dialog box. The pipe
connected should look like the one shown in Figure P-93.

Tag: |3|]]1
Number: 3001

Size: |'H]"
Spec: |POWER PLANT

Figure P-92 Values to be assigned in the
Assign Tag dialog box

Figure P-93 Pipe added between the bottom nozzle of the Boiler
Drum and inlet nozzle of the Evaporator unit on the Boiler
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Next, connect the outlet nozzle of the Evaporator unit with the right radial nozzle on the Boiler
Drum. Refer to Figure P-94 for the values to be assigned in the Assign Tag dialog box. The pipe
connected should look like the one shown in Figure P-95.

Tag: |3'DD2
Number: |3'DD2

|
|
Size: |1D" |
Spsc: [POWER PLANT |

Figure P-94 Values to be assigned in the
Assign Tag dialog box

Figure P-95 Pipe added between the outlet nozzle of the
Evaporator unit and right radial nozzle of the Boiler Drum

Note that you have to click on Next option and then choose the Accept option in the command
prompt while you are prompted to specify the piping solution.

Next, connect the top nozzle of the Boiler Drum to the inlet nozzle of the Super Heater. Refer
to Figure P-96 for the values to be assigned in the Assign Tag dialog box. The pipe connected
should look like the one shown in Figure P-97. Note that you have to click on the Next option
thrice and then the Accept option in the command prompt while you are prompted to specify
the piping solution.

Tag: |BDDH-
Number: |BDDH-

Size: |1D"
Spec: |[POWER PLANT

Figure P-96 Values to be assigned in the
Assign Tag dialog box
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Figure P-97 Pipe added between top nozzle of the Boiler Drum
and inlet nozzle of the Super Heater unit on the Boiler

Next, connect the outlet nozzle of the Super Heater with the nozzle at top of the High Pressure
Turbine. Refer to Figure P-98 for the values to be assigned in the Assign Tag dialog box. The
pipe connected should look like the one shown in Figure P-99. Note that you have to click on
Next option twice and then the Accept option in the command prompt when you are prompted
to specify the piping solution.

Tag: |3ﬂ]4
Mumber: |EDD-|-|
Size: |1D"
Spec: |POWER PLANT

Figure P-98 Values to be assigned in the
Assign Tag dialog box

Figure P-99 Pipe added between the outlet nozzle of the Super Heater
and top inlet nozzle of the High Pressure Heater
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Next, connect the bottom nozzle of the High Pressure Turbine with the inlet nozzle of the
Reheater. Refer to Figure P-100 for the values to be assigned in the Assign Tag dialog box. The
pipe connected should look like the one shown in Figure P-101. Note that you have to click on
the Next option thrice and then on the Accept option in the command prompt when you are
prompted to specify the piping solution.

Tag: |BDD5
Mumber: |EDDH
Size: |1D"
Spec: |[POWER PLANT

Figure P-100 Values to be assigned in the
Assign Tag dialog box

Figure P-101 Pipe added between the bottom outlet nozzle of
the High Pressure Turbine and inlet nozzle of the Reheater unit
on the Boiler

Next, connect the outlet nozzle of the Reheater with the nozzle at top center of the Intermediate
Pressure Turbine. To do so, choose the Route New Line tool from the Line Number Selector
drop-down of the Part Insertion panel; the Assign Tag dialog box is displayed. Enter 3006 in
the Number edit box in this dialog box. Select the line size as 10” from the Size drop-down
list. Next, choose the Assign button; the Assign Tag dialog box is closed and you are prompted
to specify the start point of the pipe. Press and hold the SHIFT key and right-click to display
a shortcut menu. Choose the Node option from the shortcut menu displayed and then select
the node of the outlet nozzle of the Reheater unit; you are prompted to specify the next point.
Move the cursor vertically upwards and enter 50’ at the command prompt; you are prompted
to specify the next point. Next, select the node of the nozzle at top center of the Intermediate
Pressure Turbine. In the command prompt, click on the Next option once and then choose the
Accept option. The pipe connected should look like the one shown in Figure P-102.
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Figure P-102 Pipe added between the outlet nozzle of the Reheater
and inlet nozzle of the Intermediate Pressure Turbine

After adding all the pipings, the plant model should look similar to the one shown in Figure P-103.

Figure P-103 The NE Isometric view of the plant model after adding pipes
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Adding Valves

After making all the piping connections, you need to add valves to the plant model. First, you
will add Gate Valves to the model. To do so, choose Gate Valve, FL, RF, 150 from the Valve
area in the Dynamic Pipe Spec tab of the TOOL PALETTES; you are prompted to specify the
insertion point. Click on the midpoint of the pipe connecting the High Pressure Heater and
the Boiler, refer to Figure P-104; you are prompted to specify the rotation angle. Enter 0 at
the command prompt and then press the ESC key, the valve is placed at the required location.

—p

Figure P-104 Placing Gate Valve on the pipe

Again, choose Gate Valve, FL, RF, 150 from the Valve area and follow the same procedure to
place it on the midpoints of the pipes numbered 3004 and 3006. Figure P-105 shows the valves
placed at the required locations.

Gate Valve placed
at the midpoint of

the pipe numbered
3008

Gate Valve placed at the
midpoint of the pipe
numbered 3004

Figure P-105 Gate Valves placed on pipes
numbered 3004 and 3006

Next, you need to place control valves on the same pipelines (numbered 3004 and 3006). To do
so, choose Control Valve, Ball, WF, RF, 150 from the Valve area in the Dynamic Pipe Spec tab
of the TOOL PALETTES; you are prompted to specify the insertion point. Specify the insertion
point for both the control valves at some distance from the previously placed gate valves. Refer
to Figure P-106 for the location of control valves to be placed on the pipelines.
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Figure P-106 Control Valves placed on pipes
numbered 3004 and 3006

Adding Structures and Supports

Now, you need to add structures and supports to the equipment which are above ground level.
First, you will add a structure that will hold the Turbine and Generator unit. To do so, invoke
the RECTANGLE tool; you are prompted to specify the first corner point. Enter 52°,-128’, 3°5”
at the command prompt, you are prompted to specify the other corner point. Enter @44, -15’
at the command prompt; a rectangle is created at the specified location. Next, choose the Plate
tool from the Parts panel of the Structure tab; the Create Plate/Grate dialog box is displayed.
Refer to Figure P-107 for the values to be entered in the Create Plate/Grate dialog box.
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A Create Plate/Grate x
Type:
Grating h Justfication
Material standard:
(®) Top I
ASTM it
Midd
Material code: &
Bott
242 v O Bster )
Thickness:
1 > | Shape
Hatch pattem: (®) New rectangular
ZGZAG b (O New polyline
Hatch scale: () Existing polyline
T |
Create Cancel Help

Figure P-107 Values to be entered in the Create Plate/Grate dialog box

After entering all the values in the Create Plate/Grate dialog box, choose the Create button in
it; you are prompted to specify the first corner point of the grate. Specify the first point of the
rectangle created earlier as the first corner point; you are prompted to specify the other corner
point. Specify the diagonally opposite corner point of the rectangle as the second corner point;
a grate will be created as shown in Figure P-108.

Figure P-108 Grate created below the Turbine and Generator unit

Next, you need to add structural members to the grate. To do so, choose the Line Model option
from the Line Model drop-down list in the Parts panel of the Structure tab. Next, choose the
Member tool from the Parts panel; the Specify start point of structural member or [Line
Settings]: prompt is displayed at the command prompt. Choose the Settings option from the
command prompt; the Member Settings dialog box is displayed. Next, choose W and W16x40
from the Shape type and Shape size list boxes, respectively and then choose the OK button to
exit the Member Settings dialog box; you are prompted again to specify the start point of the
structural member. Refer to Figure P-109 for the start point of the structural member. After
specifying the start point, you are prompted to specify the endpoint of the structural member.
Move the cursor vertically down and enter 70’ at the command prompt; the structural member
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is placed at the required location. Next, choose the Shape Model option from the Line Model
drop-down list in the Parts panel of the Structure tab; you will notice that the structural member
is not properly aligned to the Grate. To fix it, select the structural member and right-click; a
shortcut menu is displayed. Next, choose the Edit Structure option from the shortcut menu;
the Edit Member dialog box is displayed. In this dialog box, choose the top right justification
point in the Orientation window and then choose the OK button; the structural member is
properly aligned to the Grate. Similarly, add the structural members to the remaining corners
of the Grate. After adding the structural members to the Grate, it should look similar to the
one shown in Figure P-110.

Figure P-110 Grate afler adding structwral members
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Next, you need to add Grate and structural members to support the Condenser. To do so, type
RECTANGLE at the command prompt and press ENTER; you are prompted to specify the
first corner point. Enter 77°,-140°,-46” at the command prompt; you are prompted to specify
the other corner point. Enter @-14°,12” at the command prompt; a rectangle is created at the
specified location. Next, choose the Plate tool from the Parts panel of the Structure tab; the
Create Plate/Grate dialog box is displayed. Refer to Figure P-107 for the values to be entered
in this dialog box. After entering all the values in the Create Plate/Grate dialog box, choose
the Create button in it; you are prompted to specify the first corner point of the Grate. Specify
the first point of the rectangle created earlier as the first corner point; you are prompted to
specify the other corner point. Specify the diagonally opposite corner point of the rectangle as
the second corner point; a grate is created as shown in Figure P-111.

Figure P-111 Grate created below the Condenser unit

Next, follow the same procedure explained earlier to add structural members to the Grate. The
member length in this case is 20°8” (Vertically Downwards). After adding structural members
to the Grate, it should look similar to the one shown in Figure P-112.

Note
The values to be entered in the Create Plate/Grate and Member Settings dialog boxes will
remain same as mentioned before for all the gratings and structwral members to be added further.
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Figure P-112 Grate afler adding structural members

Similarly, add Gratings and structural members to the Vertical Inline Pump, Deaerator, and the
Boiler Drum. The values required to do so are given below.

For Vertical Inline Pump

First corner point of rectangle: 37°6”,-128°6,-45’
Other corner point of the rectangle: @11°,-11’
Member length: 21°8” (Vertically Downwards)

For Deaerator

First corner point of rectangle: 108°,-194°,-15

Other corner point of the rectangle: @18°,-18’
Member length: 51°8” (Vertically Downwards)

For Boiler Drum

First corner point of rectangle: -61°,-176,-14’
Other corner point of the rectangle: @10°,-10’
Member length: 52°8” (Vertically Downwards)

After adding the gratings and structural members to the Vertical Inline Pump, the Deaerator,
and the Boiler Drum, they should look similar to the ones shown in Figures P-113, P-114, and
P-115, respectively.
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Figure P-113 Vertical Inline Pump after  Figure P-114 Deaerator after adding
adding grate and structural members grate and structural members

Figure P-115 Boiler Drum afier adding grate
and structural members
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Next, you need to add support to the Cooling Tower. To do so, type RECTANGLE at the
command prompt and press enter; you are prompted to specify the first corner point. Enter
-11°,-117°,-45’ at the command prompt; you are prompted to specify the other corner point.
Enter @32°6”,-33’ at the command prompt; a rectangle is created at the specified location. Next,
type EXTRUDE at the command prompt; you are prompted to select the objects to extrude.
Select the rectangle created earlier and press ENTER; you are prompted to specify the height
of extrusion. Enter -21°8” at the command prompt; a box is placed below the Cooling Tower.

Next, choose the Attach Equipment tool from the Equipment panel of the Home tab; you
are prompted to select a single equipment item. Select the Cooling Tower; you are prompted
to select objects. Select the box created earlier and press ENTER; it will get attached with the
Cooling Tower.

After adding support to the Cooling Tower, it should look like the one shown in Figure P-116.

Figure P-116 Cooling Tower after adding support
Adding Ladders and Railings

After adding gratings and structural members to the equipment, you need to add ladders to them.
First, you will add ladder to the Turbine and Generator unit. To do so, choose the Line Model
option from the Line Model drop-down list in the Parts panel of the Structure tab. Also, make
sure that UCS is set to World. Next, type LINE at the command prompt; you are prompted to
specify the start point of the line. Snap the cursor to the mid point of the edge of the grating
and click to specify the first point, refer to Figure P-117; you are prompted to specify the next
point (second point). Next, drag the cursor vertically downwards (-ve Z-direction) and enter 70’
in the command prompt; you are prompted to specify the next point (third point). Again, drag
the cursor in +ve Y-direction and enter 6” at the command prompt. The line drawn should be
similar to one shown in Figure P-117.
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Figure P-117 Line added to the grating

Next, choose the Ladder Settings tool from the Structural Settings drop-down of the Parts
panel of the Structure tab; the Ladder Settings dialog box is displayed with the Ladder tab
chosen. Figures P-118 and P-119 show the values to be entered in the Ladder Settings dialog
box when the Ladder and Cage tabs are chosen, respectively.

A Ladder Settings bt
Ladder Cage

General Shape
Type Ladder shape:

1 e PIPEZSTD
Description [ switch % and ¥ axes

Ladder @1 Rung shape
PIPE3/45TD
Geometry
Width (1):
3-6" 2
1

Exit width (2):

S ]
Projection (3):

46"
a]

Rung distance (4):

i

cancl e

Figure P-118 Values to be entered in the Ladder tab
of the Ladder Settings dialog box
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A Ladder Settings

Ladder Cage
General

Draw cage

Description:

| + cage -@1-@2

oK

Geometry
Start height (1):

76"

=

i

n =,
=

[

= |

= o
' L]

B

3

= ®

1/4"

Cancel

x

Figure P-119 Values to be entered in the Cage tab of
the Ladder Settings dialog box

After entering all the values in both the tabs, choose the OK button to exit the Ladder Settings
dialog box. Next, choose the Ladder tool from the Parts panel of the Structure tab; you are
prompted to specify the start point of the ladder. Click on the first point of the line drawn
earlier, refer to Figure P-117; you are prompted to specify the end point of the ladder. Click on
the second point of the line, refer to Figure P-117; you are prompted to specify the directional
distance point. Click on the third point of the line, refer to Figure P-117; a ladder is placed at
the specified location. Next, choose the Shape Model option from the Line Model drop-down
list of the Parts panel. The ladder placed should look similar to the one shown in Figure P-120.
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Figure P-120 Ladder added to the Turbine and
Generator unit

Now, you need to add Railing to the Grating created for Turbine and Generator unit. To do so,
choose the Line Model option from the Line Model drop-down list in the Parts panel of the
Structure tab. Next, choose the Railing Settings tool from the Structural Settings drop-down
of the Parts panel of the Structure tab; the Railing Settings dialog box is displayed. Refer to
the Figure P-121 for the values to be entered in the Railing Settings dialog box. After entering
all the values, choose the OK button to exit the Railing Settings dialog box. Next, choose the
Railing tool from the Parts panel; you are prompted to specify the start point of the railing.
Specify the start point of the railing, refer to Figure P-122; you are prompted to specify the end
point. Click on the second, third, fourth, fifth, and sixth points successively; a railing is added
to the grating. Next, choose the Shape Model option from the Line Model drop-down list of
the Parts panel. After adding the railing, the Turbine and Generator unit should look similar
to the one shown in Figure P-123.
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A Railing Settings X
Geometry Shape
Handrail height (1) Handrail:
[ meesm [ .
1st mid rail height (2): st mid rail
19" [ PIPEZSTD | |

2nd mid rail height (3)

E— Midde rail (continuous)

Kick plate height (4): Kick plate
5" [ FBi/dxd [ .|
First post (5). Post
[ [ PIPE2STD [ . |
Second post (5):

L 9

5 6
i —
11'—'(
2 —
3 =
=
ok ] | caned | | b |

Figure P-121 Values lo be entered in the Railing
Settings dailog box
’7 Fourth point

Fifth point

Sixth point

Third paint J

First Point
(Start point)

ANVAVAVAVAWAN,

T AR .

Second point J

Figure P-122 Points to be selected while adding the
Railing
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Figure P-123 Railing added to the Turbine and
Generator unit

Similarly, add ladders and railings to the Condenser, Vertical Inline Pump, Deaerator, and the
Boiler Drum.

> Note

@ The values to be entered in the Ladder Settings and Railing Settings dialog boxes will remain

k same for all the ladders to be added to the remaining equipment mentioned above. Also, the
divectional distance point value will remain same (6”) while adding ladders.

Tip
Q The directional distance point will always lie away from the equipment to which the ladder s
to be added.

After adding ladder and railing to the Condenser, it should look similar to the one shown in
Figure P-124. Note that the ladder to be added to the Condenser should start from the midpoint
of the edge of the grate facing the High Pressure Heater and should be upto the ground level.
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Figure P-124 Condenser after adding ladder and

railing
After adding ladder and railing to the Vertical Inline Pump, it should look similar to the one
shown in Figure P-125. Note that the ladder to be added to the Vertical Inline Pump should
start from the midpoint of the edge of the grate facing the High Pressure Heater and should
be upto the ground level.

Figure P-125 Vertical Inline Pump after adding ladder

and railing
After adding ladder and railing to the Deaerator, it should look similar to the one shown in
Figure P-126. Note that the ladder to be added to the Deaerator should start from the midpoint
of the edge of the grate which does not face any of the equipment and should be upto the
ground level.
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Figure P-126 Deaerator after adding
ladder and railing

After adding ladder and railing to the Boiler Drum, it should look similar to the one shown
in Figure P-127. Note that the ladder to be added to the Boiler Drum should start from the
midpoint of the edge of the grate facing the Cooling Tower and should be upto the ground level.

=EN | |

Figure P-127 Boiler Drum after adding
ladder and railing
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Figure P-128 shows the final model of the Thermal Power Plant.

Figure P-128 Final model of the Thermal Power Plant

Creating Isometric Drawings
In this section, you will create isometric drawings for the pipelines numbered 1007,3004, and
3006.

Creating Quick Isometric Drawing for Line Number 1007

Now, you need to create the Quick Isometric drawing of the pipe numbered 1007 which connects
the High Pressure Heater and the Boiler. Zoom into the pipeline connecting the High Pressure
Heater and the Boiler and hover the cursor on the pipe, the line number of pipe is displayed,
refer to Figure P-129.
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Pipe
Layer 1007
Spec POWER PLANT

Size 20"

Tag
Line Number Tag 1007

Figure P-129 Checking the line number of the pipe

Next, choose the Quick Iso tool from the Iso Creation panel of the Isos tab; you get a prompt
as Select components to ISO or select by [Line number]. Choose the Line number option
from the command prompt; the Create Quick Iso dialog box is displayed, refer to Figure P-130.

A Create Quick lso *
Display lines Output settings
Iso Style:
| | |Check_ansiB v|
Line Mumbers: Save |sos to:
(] 1001 | |C:\Users\CADCIM-CAD Team'\Documents\PO\| | ... |
[J 1002
[] 1003
[J 1004
[] 1005
[ 1008 [[] Create DWF
[] 1007 [] Cverwrite if existing
0] 2000 - |
] 2001 Revision number: | |
(] 2002 v | Advanced..
(Treste | Cancel | I Help I

Figure P-130 The Create Quick Iso dialog box

In this dialog box, select the check box next to the line number 1007 in the Line Numbers list box.
Next, select the Check_ANSI-B option from the Iso Style drop-down list in the Output Settings
area and then choose the Create button; the isometric drawing creation will start. When the
drawing creation is complete, a balloon is displayed at the right end of the Status Bar, refer to

Figure P-131.
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ﬁl Isometric Creation Complete | X

All isometrics created successfully 1

Click to view isometric creation details...

K- -+ @ WBM
Figure P-131 Balloon displayed in the Status Bar

Next, click on the Click to view isometric creation details link displayed in the balloon; the
Isometric Creation Results dialog box is displayed, refer to Figure P-132.

A |sometric Creation Results *

View: | Al ~

= Quick lsometrics

Date and time started: 8/3/2017 10:12:33 AM
Date and time completed: 8/3/2017 10:12:55 AM
UserlD: CADCIM-CAD Team

Iso type: Check _ANSI-B

Total number of processes: 1

leos created: 1

MNumber of emors: 0

Mumber of wamings: 0

= " from 1007 pcf
File: C:\Users\CADCIM-CAD Team“Documents \POWER F@NT'-.Isometric \Check _AMNSI-B\Cuick lsos Drawings' 1007 {3).dwg
Open drawing folder in Windows Explorer

|D Copy to Clipboard | | [=> Open log file Convert Split Points Close Help

Figure P-132 The Isometric Creation Results dialog box

In this dialog box, click on the file path of the isometric drawing, refer to Figure P-132; the
isometric drawing is displayed, as shown in Figure P-133.
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Figure P-133 Quick isometric drawing for line number 1007
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Along with the isometric drawing, the bill of materials will also be displayed, refer to Figure P-134.

BILL OF MATERIALS
D | QTY ND DESCRIPTION
1 55 20" PIPE, SEAMLESS, 40, PE, ASTM A106
2 3 20" PH IMPERIAL ELBOW 90.0"
3 3 20" FLANGE WN, 150 LB, RF, ASME B16.5
4 72 |1.1/4"X8 1/4” | PH IMPERIAL STUD BOLT
5 3 20" PH IMPERIAL GASKET
6 1 20" GATE VALVE, CONDUIT, 150 LB, RF, ASME B16.10

Figure P-134 Bill of Materials for pipe number 1007

Note

Quick Isometric drawings are created only to check the piping before creating a production isometric
drawing. Moreover, these drawings are not added to the project and are available for current
session only.

Creating Production Isometric Drawing for Line Number 3004

Now, you need to create the Production Isometric drawing of the pipe numbered 3004 which
connects the Boiler and the High Pressure Turbine. Zoom into the pipeline connecting the
Boiler and the High Pressure Turbine and hover the cursor on the pipe, the line number of the
pipe is displayed, refer to Figure P-135.

Pipe

Layer 3004

Spec POWER PLANT
Size 10"

Tag

Line Murnber Tag 3004

Figure P-135 Checking the line number of the pipe
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Next, choose the Production Iso tool from the Iso Creation panel of the Isos tab; the
Create Production Iso dialog box is displayed, refer to Figure P-136.

A Create Production lso *
Display lines Output settings
i 7
lzo Style:

| 57| |Check_ANSI-B ~
Line Numbers: Save Isos to:
7100 Py C:\Users\CADCIM-CAD Team'\Documents\POWE .
[] 1002
[] 1003
[] 1004
[] 1005 [] Create D\wF

1006
E 1007 [] Owverwrite if existing
E ;gg? Rewision number:
(] 2002 v Advanced...

Cancel Help

Figure P-136 The Create Production Iso dialog box

In this dialog box, select the check box next to the line number 3004 in the Line Numbers list box.
Next, select the Final_ANSI-B option from the Iso Style drop-down list in the Output settings
area and then choose the Create button; the isometric drawing creation will start. When the
drawing creation is complete, a balloon is displayed at the right end of the Status Bar. Click
on the Click to view isometric creation details link displayed in the balloon; the Isometric
Creation Results dialog box is displayed, refer to Figure P-137.

A |sometric Creation Results X

= Production Isometrics

Date and time started: 8/3/2017 10:51:22 AM
Date and time completed: 8/3/2017 10:51:45 AM
UserlD: CADCIM-CAD Team

Iso type: Check_AMSI-B

Total number of processes: 1

lsos created: 1

Number of emars: 0

Mumber of wamings: 0

=l " from 3004 pcf
File: C:\Users\CADCIM-CAD TeamDocuments POV PLANT Isometric\Check_AMSI-B"Prodlsos Drawings 3004 (Z).dwg
Open drawing folder in Windows Explorer

|D Copy to Clipboard| | (== Open log file Convert Split Points Close Help

Figure P-137 The Isometric Creation Results dialog box
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In this dialog box, click on the file path of the isometric drawing, refer to Figure P-137; the
isometric drawing is displayed, as shown in Figure P-138.

@ [E3 B4 Gh]
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Figure P-138 Production Isometric drawing for pipe number 3004

Figures P-139 and P-140 show the Bill of Materials and Cut Piece List for pipe numbered 3004.
BILL OF MATERIALS

D ary ND gﬁ{*s/s DESCRIPTION

1| 198-3 10" 100 |PIPE, SEAMLESS, 40, PE, ASTM A106

2 3 10" PH IMPERIAL ELBOW 90.0°

3 5 107 150 | FLANGE WN, 150 LB, RF, ASME B16.5

4 48 %6 1/4" PH IMPERIAL STUD BOLT

5 5 10" PH IMPERIAL GASKET

5 1 o 150 gqﬂﬁa S‘ALVE, CONDUIT, 150 LB, RF, ASME

Figure P-139 Bull of Materials for pipe number 3004
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CUT PIECE LIST
ID LENGTH ND END1 END2
1 35'-3 3/4 10" UNIVERSAL_ET UNIVERSAL_ET
2 44'-0 13/16" 10 UNIVERSAL_ET BEVEL
3 13'-6" 10" BEVEL BEVEL
4 60°-3 3/4" 10" BEVEL UNIVERSAL_ET
3 45'-0 11/16” 10" UNIVERSAL_ET SQUARE CUT

Figure P-140 Cut Piece List for pipe number 3004

Creating Production Isometric Drawing for Line Number 3006

Follow the same procedure to create production isometric drawing for pipe numbered 3006.
Note that for this pipeline, the production isometric drawing will split into two drawing files:

3006-1 and 3006-2. Figure P-141 shows the Production Isometric drawing 3006-1.

<A
=R AT

107 WS

CONT'D ON

DWG§ 3006-2
E 271 1/8"
5 134
EL +15'-4 1/2"
“1 4 CONNECTED' TO
M-1000-N-2 150
'_/J_/ d E 8
v s
‘f P L +9'-11

Figure P-141 Production Isometric drawing 3006-1
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Figures P-142 and P-143 show the Bill of Materials and Cut Piece List for 3006-1 isometric
drawing.

BILL OF MATERIALS

D ary ND S‘E:S/S DESCRIPTION

1| 557 10" PIPE. SEAMLESS, PL, ASME B36.10

2 1 10" ELL 90 LR, BV, ASME B16.9

3 i 10" 150 |FLANGE WN, RF, 150 LB, ASME B16.5

4 3 10" 150 |FLANGE WN, 150 LB, RF, ASME B16.5

5 12 | 7/8%4 1/2° | 150 |BOLT SET, RF, 150 LB, STUD BOLT

6 | o 0 g?zg ngv/cPT; E/8” THK, RF, 150 LB, ASME
7 2 10" PH IMPERIAL GASKET

Figure P-142 Bill of Materials for 3006-1 isometric drawing

CUT PIECE LIST

D LENGTH ND END1 END2
1 3'-10 7/16" 10" BEVEL BEVEL
2 37-5 1/47 10" BEVEL BEVEL
3 14'-2 11/16" 10" BEVEL BEVEL

Figure P-143 Cut Piece List for 3006-1 isometric drawing

Figure P-144 shows the production isometric drawing 3006-2. Figures P-145 and P-146 show
the Bill of Materials and Cut Piece List for 3006-2 isometric drawing.
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Figure P-144 Production Isometric drawing 3006-2

BILL OF MATERIALS
SCH/

D Qry ND s DESCRIPTION
1| 1448 10" PIPE, SEAMLESS, PL. ASME B36.10
2 2 10" ELL 90 LR, BV, ASME B16.9
3 1 10" 150 | FLANGE WN, 150 LB, RF, ASME B16.5
4 32 1'X6 1/4” PH IMPERIAL STUD BOLT
5 2 10" PH IMPERIAL GASKET
6 | o 150 gﬂ; (\)/AL\/E, CONDUIT, 150 LB, RF, ASME

Figure P-145 Buill of Malerials for 3006-2 isometric drawing
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CUT PIECE LIST
D LENGTH ND END1 END2
1 48'-9" 10" BEVEL SQUARE CUT
2 41'-6" 10" BEVEL BEVEL
3 54'-4 7/8" 10" BEVEL BEVEL

Figure P-146 Cut Piece List for 3006-2 isometric drawing

Next, save and close all the Isometric drawings.

Creating Orthographic Drawings

Now, you need to create the Orthographic drawings for the plant model. To do so, choose the
Orthographic DWG tab from the PROJECT MANAGER; the Orthographic Drawings node
is displayed in the Orthos area. Click on the Orthographic Drawings node; it is highlighted.
Next, right-click on it; a shortcut menu is displayed. Choose the New Drawing option from
the shortcut menu; the New DWG dialog box is displayed. Next, enter Ortho in the name edit
box and choose the OK button; a new drawing file is created and the Ortho View tab is added
to the Ribbon.

Note
While creating the Orthographic Views of the plant model, make sure that the orientation of the
model is set to NE Isometric.

First, you will create the Top view of the plant model. To do so, choose the New View tool from
the Ortho Views panel of the Ortho View tab; the Select Reference Models dialog box is
displayed, refer to Figure P-147.

A Select Reference Models X

Project models:
[l Select the 20 models to be referenced in the ortho view.

Details
Last saved: Thursday, August 3, 2017 12:43:23 PM
File iz locked by user CADCIM-CAD Team' on
machine ‘DESKTOP-OAB10E2 "

Preview

Cancel Help

Figure P-147 The Select Reference Model dialog box
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In this dialog box, select the check box next to the P3D model and then choose the OK button;
the Ortho Editor tab is activated and the plant model is enclosed in the Ortho Cube, refer to
Figure P-148.

Figure P-148 Plant model enclosed in the Ortho Cube

Next, enter 0.006 as the scale factor in the Scale edit box of the Output Size panel of the
Ortho Editor tab. Also, make sure that the Top option is selected from the drop-down list in
the Ortho Cube panel of the Ortho Editor tab. Next, choose the OK button from the Create
panel of the Ortho Editor tab; you are prompted to specify the insertion point of the viewport.
Place the view on the top right of the drawing sheet; the Ortho Generation window is displayed
and the Top view of the plant model is placed in the drawing sheet once the ortho generation
is completed. Figure P-149 shows the top view of the plant model.

Figure P-149 Top view of the Plant model
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Next, choose the Adjacent View tool from the Ortho Views panel of the Ortho View tab; you
are prompted to select an orthographic view to create an adjacent view. Select the view boundary
of the Top view placed earlier; the Create an Adjacent View dialog box is displayed, refer to
Figure P-150.

A Create an Adjacent View *
Standard Views lso Views
o [ Top (current view) O &) SW lsometric
O @ Bottom O €5 SElsometric
O (@ Let O €9 NElsometric
O [ Right O &3 NW lsometric
O @ Front
O (@ Back

View Name: |Top View
| QK | | Cancel | ‘ Help ‘

Figure P-150 The Create an Adjacent View dialog box

In this dialog box, select the Front radio button from the Standard Views area and then choose
the OK button; you are prompted to specify the insertion point of the viewport. Place the front
view below the previously created top view and then press ESC to exit the Adjacent View tool.
Figure P-151 shows the front view of the plant model.

1.L % |

| A I
=i UL I | | : il )

l

Figure P-151 Front view of the plant model
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Again, choose the Adjacent View tool from the Ortho Views panel of the Ortho View tab; you
are prompted to select an orthographic view to create an adjacent view. Select the view boundary
of the front view; the Create an Adjacent View dialog box is displayed.

In this dialog box, select the Left radio button from the Standard Views area and then choose
the OK button; you are prompted to specify the insertion point of the viewport. Place the left
view at the left of the previously created front view and then press ESC to exit the Adjacent View
tool. Figure P-152 shows the Left view of the plant model.

i
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11l

N
|

Figure P-152 Lefl view of the plant model

Next, choose the Adjacent View tool from the Ortho Views panel of the Ortho View tab; you
are prompted to select an orthographic view to create an adjacent view. Select the view boundary
of the top view placed earlier; the Create an Adjacent View dialog box is displayed.

In this dialog box, select the NE Isometric radio button from the Iso Views area and then
choose the OK button; you are prompted as Specify insertion point of the viewport or [Scale/
Rotate/Existing]. Choose the Scale option from the command prompt; you are prompted to
specify the scale. Type 0.0035 at the command prompt and press ENTER. Next, place the view
at top left of the drawing sheet. Figure P-153 shows the NE Isometric view of the plant model.
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Figure P-153 NE Isometric view of the plant model

After placing all the views in the drawing sheet, it should look similar to the one shown in
Figure P-154.

Figure P-154 Drawing sheet after placing views
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Adding Annotations and Dimensions

First, you will add annotations to the components. To do so, choose the Ortho Annotate tool
from the Annotation panel of the Ortho View tab; you are prompted to select a component
to annotate. Select the Low Pressure Heater in the top view; you are prompted to specify the
annotation style. Press ENTER; the annotation is attached to the cursor and you are prompted
to specify the annotation position. Place the annotation at the right of the Low Pressure Heater,
refer to Figure P-155.

Next, follow the same procedure to annotate the other equipment in the Top view. Figure P-155
shows the top view of the plant model after adding annotations to the equipment.
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Figure P-155 Top view afler adding annotations

Now, you will add dimensions to the top view of the plant model. To do so, choose the Linear
tool from the Dimension drop-down of the Dimensions panel of the Ortho View tab; you
are prompted to specify the first line origin. Select the center point of the Deaerator; you are
prompted to specify the second extension line origin. Select the center point of the exit nozzle
of the Centrifugal Pump 2; the dimension is attached to the cursor. Place the dimension into
the drawing area, refer to Figure P-156 for location of the dimension.

Follow the same procedure to add other dimensions to the top view of the plant model.
Figure P-156 shows the top view of the model after adding dimensions.
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Figure P-156 Top view afler adding dimensions

Next, save and close the orthographic drawing.

Creating Reports and Managing Data

In this section, you will manage and create reports of the Thermal Power Plant model. To do so,
choose the Data Manager button from the Project panel of the Home tab; the DATA MANAGER
is displayed, refer to Figure P-157.
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Figure P-157 The DATA MANAGER

In the DATA MANAGER, select the Plant 3D Project Data option from the drop-down list
located at the top-left corner; the Plant 3D project data is displayed. Select the Equipment node
from the Class tree; the data related to equipment is displayed in the Data table.
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Filtering and Exporting the Data

Now, you need to filter and export the data related to a particular equipment. Right-click on
Mechanical Drivers in the Long Description(Size) column of the Data table and choose the
Filter By Selection option from the shortcut menu displayed, refer to Figure P-158; the data
related to Mechanical Drivers is displayed in the Data table.

Long

Description Manufacturer g;r::::;ble
[Size)
Heat Exchanger
Vertical Tank
Mechanicg Cut

Copy [ |
Box Type Paste B
Misc Equip Zoom i
Box Type ! Filter By Sql.sction | |
BT Filter Exclulalsng Selection | |
FOEEE Filter For: I:I |
s Remowve Filter |
Centrifugal Pump | |

Figure P-158 Choosing the Filter By Selection option

Next, choose the Export button from the DATA MANAGER toolbar; the Export Data dialog
box is displayed, refer to Figure P-159.

A Export Data x

Select export settings:
Displayed Data e
Include child nodes

(®) Active node and all child nodes
() Active node only

Enter file name and location for exported data:
CAlUzers\CADCIM-CAD Team\Documents P30 -Equi[| Browse...

oK Cancel Help

Figure P-159 The Export Data dialog box

In this dialog box, select the Active node only radio button from the Include child nodes area
and then choose the Browse button; the Export To dialog box is displayed, refer to Figure P-160.
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Figure P-160 The Export To dialog box

In this dialog box, select the Excel Workbook (*.xlsx) option from the Files of type drop-down
list and specify the file location as C:\Users\User_name\Documents\POWER PLANT. Next, choose
the Save button to exit the Export To dialog box; the Export Data dialog box is displayed again.
Choose the OK button to exit the Export Data dialog box. The data is exported to the excel
file and it is saved at the specified location.

Modifying the Data
Browse to the location C:|\Users|User_name|\Documents\POWER PLANT and open the
POWER PLANT- Equipment.xlsx file; a spreadsheet is displayed, refer to Figure P-161.
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Figure P-161 Excel Sheet displaying Equipment Data
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In the spreadsheet, change the Long Description (Size) from Mechanical Drivers to Turbine.
Figures P-162 and P-163 show the Long Description (Size) column before and after editing,
respectively.

Area Long Desc Manufacti Compatib Content I Design Pr¢ Design StcEnd Type Engageme Facing
|Mechanic.h Drivers FL RF

Figure P-162 Long Description (Size) before editing

Area Long Desc Manufacti Compatib Content Iz Design Pre Design StcEnd Type Engageme Facing
|Turbine _l FL RF

Figure P-163 Long Description (Size) afler editing

Next, save the excel file after making all the modifications in it and close it.

Importing the Data

Now, you will import the modified data into the DATA MANAGER. To do so, switch to AutoCAD
Plant 3D and open the DATA MANAGER if'it is closed. In the DATA MANAGER, make sure
that Plant 3D Project Data is selected in the drop-down list located at the top left corner and
equipment data is displayed in the Data table. Next, choose the Import button from the DATA
MANAGER toolbar, refer to Figure P-164; the AutoCAD Plant message box is displayed, refer

to Figure P-165.
2 R

Figure P-164 Choosing the Import button

A AutoCAD Plant *

Alog file for accept and reject will be created in the same
folder as the impart file.

[[] Do not show me this again.

OK

Figure P-165 The AutoCAD Plant message box

Next, choose the OK button from the AutoCAD Plant message box; the Import From dialog
box is displayed, refer to Figure P-166.
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Figure P-166 The Import From dialog box

Next, browse to the location C:|Users|User_name\Documents\POWER PLANT and open the
POWER PLANT- Equipment.xIsx file; the Import Data dialog box is displayed, refer to
Figure P-167.

A Import Data X

Select file to import:
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Select import settings:
Displayed Data e
oK Cancel Help

Figure P-167 The Import Data dialog box

Next, choose the OK button from the Import Data dialog box; the data in the excel file is
imported into the DATA MANAGER, refer to Figure P-168.

Long Content Iso Design

~ . ~ Compatible = ~
Description Manufacturer standard Symbeol Pressure

| Size) Definition Factor

Figure P-168 The Data lable after importing the data

After importing the data into the DATA MANAGER, choose the Accept All button from the
DATA MANAGER toolbar to accept the changes made to the data, refer to Figure P-169, and
then exit the DATA MANAGER.

@ |2F & xIE

Figure P-169 Choosing the Accept All button
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Next, choose the Save button from the Application menu and then the Close button to close
the file.

Using Autodesk AutoCAD Plant Report Creator and Generating Reports
Now, you will be using Autodesk AutoCAD Plant Report Creator to generate reports.
To do so, double-click on the shortcut icon of AutoCAD Plant Report Creator
2018 - English available on your desktop; the Autodesk AutoCAD Plant Report Creator will
be displayed, refer to Figure P-170.

A Autodesk AutoCAD Plant Report Creator - [m| X

Project

Project Name:
Project Version:
Project Description:
Report Configuration
Edit... Settings

File Path:
Qutput Type:
Target:
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Project Data Drawing Data

Help Preview Prirt/Export Close

Figure P-170 The Autodesk AutoCAD Plant Report Creator

In Autodesk AutoCAD Plant Report Creator, select the Open option from the Project drop-down
list; the Open dialog box will be displayed. Next, browse to the location C:\Users\User_name)
Documents\POWER PLANT and double-click on the Project.xml file; the data sources related to
the POWER PLANT project will be displayed in the Autodesk AutoCAD Plant Report Creator.
Select the 3D Parts option from the Report Configuration drop-down list and select the Project
Data radio button from the Data Source area, if not already selected. Next, choose the Print/
Export button from Autodesk AutoCAD Plant Report Creator; the PDF Export Options dialog
box will be displayed. In this dialog box, enter the values in different text boxes as shown in
Figure P-171 and then choose the OK button; the report will be exported in the PDF file format
and the Export results window will be displayed, refer to Figure P-172.
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Figure P-171 The PDF Export Options
dialog box
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Figure P-172 The Export Results window

In this window, double-click on the file path; the PDF file containing the 3D Parts report will be
displayed, refer to Figures P-173 and P-174.
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Bill of Material Autodesk

Project: POWER PLANT
MNota: Fixad-langth pipes are not included in pipes.

Quantity Unit Description ND Standard Schedule Material PN Angle

Type: Pipe, Seamless
200-2" in Fipe, Seamless, PL, ASME B26.10 10in  ASME B38.10

Type: PIPE, SEAMLESS

Boe-a" in PIPE, SEAMLESS, 40, 10" ND, PE. ASTM A108 10in  ASTM A1DE 100 A106
2310 in FIPE, SEAMLESE, 40, 12" MD, PE. AZTM A108 1Zin ASTM A1DE 100 A106
2110 in FIPE, SEAMLESES, 40, 18" ND, PE. ASTM A108 16in  ASTM A106 100 A106
122407 in FIPE. SEAMLESS, 40. 20" ND. PE. ASTM A108 20in  ASTM A106 100 A106

Type: Elbow 90.0°

19 FH IMPERIAL Eloow £0.0° ND 107 10in
2 FH IMPERIAL Elbow 80.0° NDO 12 12in
8 FH IMPERIAL Elbow 20.0° ND 18" 18in
3 FH IMFERIAL Elow £0.0° ND 207 20in

Type: ELL 90 LR
3 ELL 00 LR. BV. ASME B16.9 10in  ASMEB18.08

Type: FLANGE WN

3 FLANGE WN. RF, 150 LB, ASME B16.5 10in  ASMEB18.5 150
8 FLANGE WN_12" ND. 150 LB. RF. ASME B18 5 1Zin  ASMEB185 150
8 FLANGE WN. 18" ND. 150 LB, RF, ASME B18.3 16in  ASMEB18.5 150
g FLANGE WN. RF, 150 LB. ASME B18.5 20in  ASMEB18.5 130

Type: Bolt set
2 Bolt set, RF, 150 LB, Stud Bolt 10in 150
1 Boit set, RF, 150 LB, Stud Bolt 20in 130

Type: Stud Bolt

10 FH IMPERIAL Swd Bolt 1768 114" Lg wiZ Hex Nut 1 10in
8 FH IMPERIAL Stud Bolt 1 1/87%8 3147 Lg wiZ Hex. Mut 1 1/8" 12in
8 PH IMPERIAL Stud Bolt 1 1/47x7 1/2° Lg wiZ Hex. Nut 1 1/4” 16in
7 PH IMPERIAL Stud Bolt 1 1/47x8 1147 Ly wi2 Hex. Nut 1 174" 20in

Figure P-173 Page 1 of the 3D Parts report in PDF file

Quantity Unit Description ND  Standard Schedule Material PN Angle
Type: Gasket

14 PH IMPERIAL Gasket ND 107 10in

5 PH IMPERIAL Gasket ND 12° 12in

8 PH IMPERIAL Gasket ND 167 18in

7 PH IMPERIAL Gasket ND 20” 20in

Type: Gasket, SWG
8 GASKET, SWG, 10° ND, 1/8" THK, 150 LB, RF, ASME B16.20 10in ASME B16.20 150
1 GASKET, SWG, 20" ND, 1/8" THK, 150 LB, RF, ASME B16.20 20in  ASME B16.20 150

Type: Control Valve, Ball
2 CONTROL VALVE, BALL, 10" ND, 150 LB, RF, ISA 75.08.02, 11 63/100" LG 10in  I1SA75.08.02 150

Type: Gate Valve
2 GATE VALVE, CONDUIT, 10" ND, 150 LB, RF, ASME B16.10, 13" LG 10in  ASME B16.10 150
1 GATE VALVE, CONDUIT, 20" ND, 150 LB, RF, ASME B16.10, 18" LG 20in  ASME B16.10 150

Figure P-174 Page 2 of the 3D Parts report in PDF file

After viewing the report, close the PDF file. Next, choose the OK button from the Export results
window and close Autodesk AutoCAD Plant Report Creator.



